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Preface

Thank you for selecting the MONITOUCH V6 series.
For proper set-up, you are requested to read through this booklet to understand more
about the product.

For more information about V6 series, refer to the following manuals.

Contents Manual Name Manual Number
Connection with PLCs, communication V6 Hard Specificati
parameter setting, etc. araware specifications 2006NEX
The V-SFT operating procedure is Ref M | (O i 043
described. eference Manual (Operation) 1043NE
The functions and instructions of )
V7/V6 series are described. Reference Manual (Function) 1044NE
V series creation examples Tutorial 1022NE

For further details about the PLC, see the manual attached to each PLC.
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. Notes:

1. This booklet may not, in whole or in part, be printed or reproduced without the prior
written consent of Hakko Electronics Co., Ltd.

2. Information in this booklet is subject to change without prior notice.

3. This booklet is intended to give information about MONITOUCH hardware.
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Notes on safe usage of MONITOUCH

Inthis" Specificationsfor V608CH", you will find various notes categorized under the following
three levels with the signal words "Danger," "Warning," and "Caution."

These signal words are to warn the user of possible misuse of the unit. To comprehend the
critical notes on the safe procedure, you must go through this manual before you install
MONITOUCH and operate it correctly.

Danger
DANGER indicates an imminently hazardous situation which, if not
avoided, will result in death or seriousinjury.

Warning

WARNING  indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

Caution

cauTion  Indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury and could
cause property damage.




Notes on System Design

WARNING

Never usetheinput function of MONITOUCH such asthe touch switch
for an emergency switch because it could threaten a human life or
break a part of the unit.

Please design the system of the unit in order to respond to amalfunction
of the touch switch.

CAUTION

Never bundle input/output cables with high-voltage and large-current
cables such as power supply cables. Keep input/output cables at |east
200mm away from power supply cablesin order to avoid malfunction
caused by noise.

Asfor theusein thefacilitiesrelated to nuclear energy or inthefacilities
of official importance, please consult with our distributer about it.

Notes on Installation

CAUTION

Operate MONITOUCH under the conditionsindicated by the manual.

If you don't set the conditions indicated by the manual for the unit, it
could cause fire, malfunction, physical damage or deterioration.

Maintain the following conditions in order to avoid fire or trouble.

Don't let the unit come in contact with corrosive gas, flammable
gas, solvents, grinding fluids or cutting oil.

Never let the unit be exposed to high temperature, high humidity,
and other outside weather conditions.

Don't allow the unit to be exposed to excessive dust, salt, and
metallic particles.

Don't allow the unit to be shaken or hit by other objects.

Equipment must be correctly mounted so that the main terminal will
not inadvertently be touched during an application.




Notes on Cable Connection

Turn off the power supply when you set up the system or connect the

cables, otherwise you will get an electric shock or damage the unit.
DANGER

Connect the cables correctly to the terminals of MONITOUCH in
accordance with the specified voltage and wattage. Over-voltage, over-
wattage and the incorrect cable connection could cause the unit to be
damaged physically or functionally and also could result in fire.

CAUTION

Ground FG terminal which must befor theunit. Thelevel of grounding
resistanceis less than 100Q.

Prevent any conductive particles from entering into MONITOUCH.
The conductive particles could cause fire, trouble, or malfunction of
the unit.

Notes on Maintenance and Operation

Never touch the terminals while the power supply is on, otherwise

DANGER you will get an electric shock.

Y ou must put the cover of the terminals on the unit when you turn on
the power and operate it.

Theliquid crystal in the LCD panel is a hazardous substance. If the
LCD panel is damaged, never swallow the leaked liquid crystal. If the
liquid crystal spills on your skin or clothing, use soap and wash off
thoroughly.




Hakko Electronics Co.,Ltd. is not responsible for an unauthorized
CAUTION person who may fix, disassemble, or reconstruct any unit.

Switch resolution of the MONITOUCH
V608CH is determined by the analog-
type resistance film. Do not press two or
more positions on the screen at the same
time.

Pressing two positions at the same time

If two or more posi’[ions are pressed at activates the switch in the center.
the same time, the switch located between the pressed positions
activates. Please take note of this.

Avoid displaying the same patterns for hours.

It may cause afterimages due to the property of LCD display. If you
use the fixed patterns for hours, use the auto-OFF function of the
backlight.
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1. Features 1-1

1 Features

1

2)

3)

4)

5)

Handy-sized, Portable Unit
A slim, space-saving design makes the unit easily portable. It can be set up as either a wall-mount or
desktop unit using the dedicated mounting hardware (optional; V6H-WF) or stand (optional; V6H-ST).

128 Colors Displayable on the 7.7-inch LCD
Equipped with a high-intensity, high-resolution 7.7-inch STN color LCD, rich color display becomes
possible on the 128-color V6 series screen. Bitmap files can also be displayed in extremely high quality.

VGA Display
A high-resolution VGA (640 dots by 480 dots) display is used. More information can be displayed on the
screen.

Safety Function

A push-lock-type emergency stop switch (forced open-circuit mechanism) is provided as standard.

Also, to prevent misoperations, a deadman switch (3-position switch available as an option) is provided.
It is possible to implement increased security by adding a key switch (optional) that restricts the operation
only to the person who has the relevant key.

CF (Compact Flash) Card Supported
V6 series supports large-capacity CF cards.
 Saving screen data and system programs
Since multiple screen data can be saved, it is possible to exchange screen data in the field.

» Saving memo pads
Data in memo pads can be saved. Saved files can be converted into bitmap files using CF Card
Manager included in V-SFT Editor.

* Saving patterns
Patterns that are used for screens can be saved on the CF card. Itis possible to save memory for
screen data.

» Saving hard copy image as a file
Screen display can be saved as a file using the macro command.
Also, it is possible to convert it into a bitmap file using CF Card Manager included in V-SFT Editor.

» Reading and writing CSV files
CSV files can be imported into V608CH using the macro command. Data in the PLC memory or V6
internal memory can be output to a CSV file.

» Sampling function
Sampling data can be saved on the CF card. Sampling data can be converted into a CSV file using the
macro command, which enables data editing on the computer.
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2 Notes on Usage

Environmental Limits 5. Avoid any place in which there is the possibility

that water, corrosive gas, flammable gas,
1. Use MONITOUCH at an ambient temperature of solvents, grinding fluids or cutting oil can come
0~50°C, and a relative humidity of 85 %RH. in contact with the unit. Never install the unit in

a place where dust, salt and metallic particles
are present.

[-co 0000

2. Avoid places where moisture may easily
condense due to sudden temperature changes.

Locations
= OH ’ 1. Secure sufficient space around MONITOUCH for
8 b Hil B ventilation.
N |8 g
// .
, .

3. Avoid direct sunlight.

(o0 cooo
00 0000

2. Never attach MONITOUCH to the top of any
apparatus generating high levels of heat (heater,
transformer, large-capacity resistor, etc.).

00 0000
00 0000

4. Never install MONITOUCH in a place where
impacts or vibrations may be transmitted.

3. Never install MONITOUCH in the same
compartment as high-voltage equipment. The
unit should be at least 200 mm away from
highvoltage lines or power cables.

codloo
00 0000
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Usage 6. Never operate the display by using a tool with a

sharp point like a screwdriver.

1. An emergency stop circuit must be composed of Touch the display by fingers.

an external relay circuit with a start signal for

MONITOUCH built in. Do not create switches
on MONITOUCH to be used in case of emer-
gency.

atool with a
sharp point
like a screwdriver

s
ﬁ'ﬂ e

Uy

2. MONITOUCH has a glass screen. Never drop
or subject the unit to strong impacts.

00 0000

3. Inadry environment, MONITOUCH may
generate a large amount of static electricity.
Therefore, before touching the unit, touch a
grounded metallic section to discharge the static
electricity.

4. Application of thinner may discolor
MONITOUCH. Use alcohol or benzine available
commercially for cleaning.

5. Never remove any printed circuit board from
MONITOUCH. (This will harm the unit.)
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3 System Composition

System Composition / Model Indication / Peripheral Equipment / Recommended CF Cards

System Composition

The following illustration shows possible system configurations using V608CH.

Panel Editor

; Transferrin
for V series 9

screen data
Creating screens |E= V6-CP
° \\ N ———————

|

-00 0000
00 0000

Personal Computer (PC) V6
Transfegring During operation
screen data (Universal serial Cable
ete. communication) V6-BCD
RS-232C/RS-422
CF Card During operation

(Link communication)
RS-232C/RS-422

] [l

Link Unit Barcode Reader

Universal-purpose
computer

List of Models

The characters on the right of model names represent optional features and special specifications.

V608CH[ ]
B

O] Deadman switch Key switch
0 momentary w/o
1 momentary with
2 3-position w/o
3 3-position with




1. System Composition

Peripheral Equipment

The following options are available for V6 series.

V-SFT

Application software for editing screen data
(for Windows98/NT4.0/Me/2000/XP)

V6-CP (data transfer cable) 3 m

Connects V6 to a personal computer.

V6H-C[ (external connection cable)
O: 3, 5,15, 20 (m)

30-wire cable for PLC communication or power supply

V6H-ST (desktop stand)

Stand for desktop use. The vertical angle can be set as desired.

V6H-WF (wall-mount bracket)

Mounting bracket for wall-mount use. Two pieces (one for the V6 and the
other for the wall) makes a set.

* This wall-mount bracket cannot be used if the modular jack is in use.

V6H-WF1 (wall-side piece of wall-mount bracket)

Mounting bracket for wall-mount use. This is the piece to be mounted on
the wall.
* This wall-mount hardware cannot be used if the modular jack is in use.

V608C-FL (backlight)
V608H backlight for replacement
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V6H-RB (battery)

Backup battery for the built-in clock

V-MDD (ACPU/QNACPU/FXCPU dual port interface)

Add-on connector with two ports, specifically designed for the connector
on Mitsubishi's ACPU/QnNACPU/FXCPU programmer. This interface can
be used when connecting V6 series directly to Mitsubishi's ACPU/
QnACPU/FXCPU programmer.

V6-BCD (barcode reader cable) 3 m

Connects V6 and a barcode reader.

V6-TMP (V-link cable) 3 m

Connects V6 and a personal computer (PLC).

Recommended CF Cards

The recommended CF cards are shown in the following table.

Manufacturer Type Capacity Manufacturer Type Capacity
Kodak KPCN-32 32MB 1<O Data Device CFS-iVxxx 32MB
SanDisk SDCFB-64-505 64MB 64MB
SDCFB-xxxx-801 32MB 128MB
64MB 256MB
96MB 512MB
128MB Hagiwara Sys-Com HPC-CFxxZX 32MB
192MB MELCO RCF-xx 64MB
256MB 128MB
384MB 256MB
512MB 512MB
1GB
1«0 Data Device CFS-32MA 32MB
CFS-xxM(HI) 32MB
64MB
128MB
256MB
512MB




1. Names of Components

4 Names of Components

Front Side
1. Deadman switch
e ) / 3-position switch (Option)
\w®o~‘ //C) )
/ \ 2. Emergency stop switch
= +—@® 3. ENBlamp
o Q 4. Function keys (refer to P2-16)
i i olll 4 _
o) 0] 5. Output switches
LO (0] 6. Display
® [® @) 5 7. Power lamp
- @ ! ©. 8. Key switch (Option)
Rear Side
9 @
9. TB1: Terminals for PLC communication,
) o °
power supply and output (to outside)
|| || 10. MJ1 : for data transmission
o o
11. SW1 : Terminal resistance (upper:on)
T ® 12. Mounting holes for cable clamp and neck strap
13. Mounting holes for bracket (V6H-WF : option)
14. Connector for battery (V6H-RB : option)
maintaining the data of built-in clock
= 15. I/F cover
o—®@
<
Side Bottom

16. CF card interface

17. Mounting hole for communication cable



1. Dimensions

5 Dimensions

Dimensions of V608CH

Unit : mm

@ Top view

[ | 1 J
LHJ =
® Side view @ Front view @ Rear view
259
© ©
N %\
]] :KSQ O C o
i <o o 1
0 0] 0]
0] 0]
o 0]
®
N e} o]
N © [
24
47
® Bottom view
106
—— —

i I —
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6 Specifications

General Specifications

ltem Type V608CH
Rated Voltage 24V DC
Permissible Range 24V=£10% DC
_§ of Voltage
@ | Permissible Momentary Power Failure within 10ms (24VDC)
g Demand 20W or less
< Rushed Electric Current 13A
2ms
With-stand voltage DC external terminals to FG : 500V AC per min.
Insulation Resistance 500V DC, 10M Q or more
= [ Ambient Temperature 0°'C~+50°C
% Storage Ambient Temperature -10°C~+60°C
-§ Ambient Humidity 85% RH or less (without dew condensation)
"'_E Dust No conductive dust
é Solvent Resistance No cutting oil or no organic solvent to cling to the unit
T Corrosive Gas No corrosive gas
Vibration Resistance Vibration frequency: 10~150Hz, Acceleration: 9.8m/s?(1.0G)
s ¢ 3 directions of X, Y and Z: one hour
‘;:;ig Shock Resistance Pulse shape: Sine half wave,
Peak acceleration: 147m/s2 (15G), 3 directions of X, Y and Z: six times
5 gg Noise Resistance Noise voltage: 1000Vp-p, noise width: 1us
§§§ Static Electricity Discharge Resistance Contact: 6kV , Air: 8kV
Grounding Grounding resistance: less than 100Q
@ | Structure Protection structure: complies with IP65 (when using I/F cover)
:g excluding V608CH2, V608CH3
2 Form: in a body
8 Mounting procedure: Hold, Hang, Stand
.g Cooling System Cooling naturally
é Weight Approx. 1.2kg
Dimensions W X H X D (mm) 259 X 232 X 47 (Excluding Emargency switch)
Case Color Equivalent to the Munsell color system N-2.0 (Black)
Material PC/ABS
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Display Specificarions

Item

Specifications

Display Device

STN color LCD

Resolution W X H (dots)

640 X 480

Dot Pitch W X H (mm)

0.082 X 0.246

Effective Display

Size 7.7 inches

Color

128 colors + 16 blink colors

Backlight

Cold-cathode tube (replaceable by the user)

Average Backlight Life *

Approx. 40,000 h

Auto Light OFF Function

Always ON / Auto OFF

Contrast Adjustment

Adjustable with a function switch

POWER Lamp

ON when the power is on

ENB Lamp

ON when the screen is operable

Surface sheet

Material : PET

* Room temperature of 25°C is assumed.
The backlight life is regarded as expired when brightness is decreased to 50% of the initial level.

Touch Panel Specifications

Item

Specifications

Switch Resolution

1024 (W) X 1024 (H)

Type

Analog resistance film

Average Mechanical Life

1 million actuations or more

Surface Treatment

Hard-coated, 5% non-glare treatment

Function Switch Specifications

Item

Specifications

Number of Switches

12 (4: external direct output)

Switch Type

Membrane switch

Average Mechanical Life

1 million actuations or more

Emergency Stop Switch Specifications

Item

Specifications

Number of Switches

1

Type

Push-lock type (2 "b" contacts, common)

Average Mechanical Life

100 thousand actuations or more

Rating

Rated using voltage 24V Resistance load 1.0A
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Deadman Switch Specifications

Iltem

Specifications

Number of Switches

1

Type

Momentary type (1 "a" contact)

Average Mechanical Life

1 million actuations or more

3-position Switch Specifications (Optional)

Item

Specifications

Number of Switches

1

Number of Contacts

1 “a” contact (double interrupt, slow action)

Average Mechanical Life

1 million actuations or more (1P—2P—1P)

100 thousand actuations or more (1P—2P—3P)

Operating Pressure (Reference)

Pressure required for direct circuit actuation: 30 N or more

Key Switch Specifications (Optional)

Iltem Specifications
Number of Switches 1
Number of Contacts 1"a" contact

Average Mechanical Life

250 thousand actuations or more

Average Electrical Life

100 thousand actuations or more (open/close frequency: 1200 times/h)

Rating

Rated using voltage 24V Resistance load 1.0A

Interface Specifications

Item

Specifications

* PLC connection
* Power supply
« External output

Multi-step Terminal Block (TB1)

RS-232C, RS-422/485

Asynchronous mode

Data length: 7, 8 bits

Parity: even, odd, none

Stop bit: 1, 2 bits

Baud rate: 4800, 9600, 19200, 38400, 57600, 76800, 115200 bps

8-pin Modular Jack (MJ1)
* Screen data transfer

* V-Link

« Barcode

* |/F cover or wall-mount
hardware unusable

RS-232C

Data length: 7, 8 bits

Parity: even, odd, none

Stop bit: 1, 2 bits

Baud rate: 4800, 9600, 19200, 38400, 57600, 76800, 115200 bps
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Display Function Specifications

Iltem Specifications
Display Language* Japanese  :Eng./W. Europe; Chinese . Chinese (simplified): Korean
Characters §1/4-size, L-byte| ANK code Latin 1 EASCII codei ASCII code ASCII code
iZ-byte (16-dot) |JIS 1stand 2nd " Chinese : Chinese (simplified) :Hangul (without Kanji)
obyle(B2do | dsist L
Size of Chara'cters 1/4-size : 8 X 8 dots

1-byte :8 X 16 dots
2-byte :16 X 16 dots or 32 X 32 dots
Enlarge : W, 1-8 H, 1-8

Number of Characters Resolution 640 X 480
1/4-size 80 columns X 60 lines
1-byte 80 columns X 30 lines
2-byte 40 columns X 30 lines

Property of Characters Display property : normal, reverse, blinking, bold, shadow

Color : 128 colors + blinking 16 colors

Kind of Drawing Lines : line, continuous lines, box, parallelogram, polygon
Circles : circle, arc, sector, ellipse, elliptical arc, elliptical sector

Others : tile patterns

Property of Drawing Type of lines : 6 types (fine, thick, dot, chain, broken, two-dot chain)
Tile patterns : 16 types (incl. user-definable 8 types)

Display property : normal, reverse, blinking

Display color : 128 colors + blinking 16 colors

Color specification : foreground, background, boundaries (line)

*The following fonts are also available.
For the details of Gothic, Central Europe, Cyrillic, Greek, and Turkish, refer to "Reference Manual

(Operation)" and "V-SFT Additional Specifications."

Drawing Environment

Iltem Specifications
Editing Method Exclusive editing software
Editing Tool Name of exclusive editing software  : V-SFT (ver.1.2.18.0 or later)

Personal computer  : Pentium Il 450MHz or more is recommended
OS : Microsoft Windows 98/Me/NT version 4.0/2000/XP

Capacity of hard disk required : free area of approx. 460MB or more

Display : Resolution of 800 X 600 or more is recommended
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Function Performance Specifications

Item Specifications
Screens Max. 1024
Screen Memory FP-ROM (flash ROM), Appox. 2,760kbytes (different from the language)
Switches 768 per screen
Actions of Switch Set, reset, momentary, alternate, to light

(possible to press a function switch and a display switch at the same time)

Reverse, blinking, exchange of graphics

Lamps
P 768 per screen

Graphs Pie, bar, panel meter and closed area graph can be displayed without limit.
Total capacity per screen: within 128kB
Statics and trend graphs: Max. 256 per layer *1

2 | Numerical Data Display | No limits, total capacity per screen: within 128 kB
§ Character Display No limits, total capacity per screen: within 128 kB
% Message Display Resolution : 640X480, Max. 80 characters
e No limits, total capacity per screen: within 128 kB
Messages 6144 lines
Sampling Sampling display of buffer data
(constant sample, bit synchronize, bit sample, relay sample, alarm function)
Multi-Overlaps Max. 1024
Data Blocks Max. 1024
Graphic Libraries Max. 2560
Patterns Max. 1024
Macro Blocks Max. 1024
Page Blocks Max. 1024
Direct Blocks Max. 1024
Screen Blocks Max. 1024
Calendar provided
Buzzer provided, 2 types (intermittent short and long sounds)

Back-light Auto OFF Function | ON at all time, specified freely

Self-diagnostic Function Self-test function of switches
Check function of communication parameter setting
Check function of communication

*1 Layer : 4 per screen (base + 3 overlaps)
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7 Terminal Block (TB1)

1. Signal Assignment (TB1)

Pin arrangement is shown below:

TB1

TxD | RxD | +SD | -SD |+RTS|-RTS| D01

D03 |COM-|EMGLEMG2

+24V | OV

RTS | CTS | SG |+RD |-RD [+CTS|-CTS| D02 | D04 |E_COM|KEY1|KEY2| FG

com

Signal Name Contents Signal Name Contents
TXD RS-232C send data RTS RS-232C control signal
RXD RS-232C receive data CTS RS-232C control signal
+SD RS-485 send data (+) SG Signal ground
-SD RS-485 send data (-) +RD RS-485 receive data (+)
+RTS RS-485 control signal -RD RS-485 receive data (-)
-RTS RS-485 control signal +CTS RS-485 control signal
D01 External output switch 1 -CTS RS-485 control signal
D03 External output switch 3 D02 External output switch 2
COM- External output switch common D04 External output switch 4
EMG1 Emergency stop 1 E_COM Emergency stop 1, 2 common
EMG2 Emergency stop 2 KEY1 Key switch 1
+24V Power supply KEY2 COM | Key switch 2

ov Ground FG Frame ground




1. Terminal Block (TB1) @KL

2. Power Supply Terminal

Connect the power supply cable to the shaded positions.

TB1

TXD | RxD | +SD | -SD |+RTS|-RTS| D01 | D03 |COM-[EMG1[EMG2|+24V| OV

RTS | CTS| SG |+RD |-RD |+CTS|-CTS| D02 | D04 [E_COM|KEY1|KEY2| FG
CoM

Power Cable Connection
* A power supply source within the allowable voltage fluctuation should be used.
» Use a power supply source with low noise between cables, and between cables and the ground.
* To reduce a possible voltage drop, use a thicker cable.

» Keep the 24-VDC line sufficiently away from high-voltage, large-current cables.

Grounding
c Make sure that MONITOUCH is well grounded.
(grounding resistance less than 100 ohm or less)

Communication/ Power supply cable

To supply the power from PLC

V6 PLC

» Connect FG on the side of the unit to the PLC earth, and ground the
PLC earth.

Grounding with resistance 100 Qor less

To supply the power from the external unit

+ Connect FG on the side of the unit to the PLC earth, and ground Power supply @
the PLC earth if the input power supply between PLC and the cable

i i External
external equipment is the same. V6 e unply pPLC

| T

Grounding with resistance 100 Q or less

Communication

cable
« Ground individually if the input power supply between ﬁ Power supply ﬁ
them is different. o
xternal | Y |
Power Supply[— | ve — PLC
Grounding with resistance 100 Qor less Grounding with resistance 100Q or less

« If the grounding conductor is shared or if the grounding cable is connected to a beam of the building, a
harmful influence may be exerted. Be sure to avoid such connection.

« If grounding causes a malfunction, separate the FG terminal from the grounding conductor.
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3. Emergency Stop Switch

The emergency stop switch signal is output. Connect the cable to the shaded positions.

TB1

TxD | RxD | +SD | -SD |+RTS|-RTS| D01 | D03 |COM-[EMGLEMG2| +24V | 0V

RTS | CTS | SG | +RD

-RD [+CTS|-CTS| D02 | D04 [E.COM|KEY1|KEY2| FG
CoMm

Emergency Stop Switch Specifications

Iltem

Specifications

Number of Switches

1

Type

Push-lock type (2 "b" contacts, common)

Average Mechanical Life

100 thousand actuations or more

Rating

Rated using voltage 24V Resistance load 1.0A




1. Terminal Block (TB1)

4. External Output Switches

The external output switch signal is output to the external equipment. Connect the cable to the shaded
positions.

TB1

TxD | RxD | +SD | -SD |+RTS|-RTS| DO1 | DO3 |COM-EMGIEMG2|+24V | OV

RTS [ CTS | SG |+RD |-RD [+CTS|-CTS [[D02 | D04 |E_COM|KEY1|KEY2| FG

COM
External Output Switch Specifications
Iltem Specifications

Number of Output Points 4

Output Form Synchronous output

Rated Voltage 12 to 24 VDC

Max. Drive Current 50 mA

Insulation Photo coupler insulation

Circuit Diagram

121D [eusau|
L I
P

COM

DC12-24V

{j} Do not use the external output switch for emergency.
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5. Key Switch (Optional)

The key switch signal is output. Connect the cable to the shaded positions.

TB1

TXD | RxD [ +SD | -SD [+RTS|-RTS| DO1 | D03 |COM-[EMG1EMG2(+24V| OV

RTS|CTS | SG |+RD |-RD [+CTS|-CTS| D02 | D04 (E_COM|KEY1|KEY2| FG

COoM
Key Switch Specifications
Item Specifications
Number of Switches 1
Number of Contacts 1"a" contact
Average Mechanical Life 250 thousand actuations or more
Average Electrical Life 100 thousand actuations or more (open/close frequency: 1200 times/h)
Rating Rated using voltage 24V Resistance load 1.0A

6. Serial Interface

PLC communication can be performed through the serial interface. Connect the cable to the shaded
positions.

TB1

TXD | RxD | +SD | -SD |+RTS|-RTS| D01 | D03 [COM-[EMGIEMG2|+24V | OV

RTS | CTS | SG | +RD [-RD [+CTS|-CTS| D02 | D04 |E_ COM|KEY1|KEY2| FG

COM
Interface Specifications
Item Specifications
Signal Level RS-232C or RS-422/485
Baud Rate 4800, 9600, 19200, 38400, 57600, 76800, 115200
Parity Even, odd, none
Data Length 7, 8 bits
Stop Bit 1, 2 bits
Connection Terminal block connection
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7. Connection

Three kinds of V6 to PLC connection styles are available as shown below.

1:1 Connection

Connect one V6 to one PLC (1:1).
Refer to [8. 1:1 connection] page 1-21.

90 0000 |
<
o
©0 0000 Q
g

Via RS-232C or RS-422 (RS-485) interface

1:n Link Communication (Multi-drop)

Refer to [9. 1:n Link Communication] page 1-23.

[-00 0000
| oo 0000

RS-422/485  Maximum length 500m
\ (from V6 to the last PLC)

N : 1 Link Communication (Multi-Link)

Refer to [10. n:1 Link Communication] page 1-25.

V6:1 V6:2 V6:3 V6:n
Lo ol O+ o O oA
g NIBIE HIE ] g g
g HIE: HEIE g g §
o ° o o ) ) o o
ol J°of [BE=—T° [P—=—o—"°] E 2

RS-485 Maximum length 500m
(from PLC to the last V6)
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8. Cables

» Use cables of OD 8.5 to 10.5 mm.
If a cable less than 8.5 mm in diameter is used, IP65 cannot be retained.

* Recommended cables
Use Hakko Electronics’s cable “V6H-C (1 (J: 3.5, 15, 20 m).”

 Tighten terminal screws within the following torque range when connecting the cable.

Screw Size | Tightening Torque | Single Cable : Twisted Cable

M2 0.22-0.25N-m 0.14-1.5mm2 : 0.14-1.0mm2
G:!::‘g Do not tin core wires.
¢ Recommended bar terminals
Manufacturer Type
Al0.25-6YE
Phoenix Contact Al0.34-6TQ
Al0.5-8WH
¢« Recommended connectors
Manufacturer Name Type
Adaptor NJW-2831-PM
Nanaboshi Electric
Receptacle NJW-2831-RF

<Example>

iﬁ Receptacle

Note on Communication Cable Connection

¢ Do not connect the communication
cable together with the electric circuit.

Cable duct

* Do not tie the communication cable

Communication cable

” Communication cable

with electric cables in the duct as
shown at right. Doing so may cause

Power/control cables

a noise problem.

Power/control cables

e Connect the communication cable

independently from other cables. L

Insulating cable tie
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8 1:1 Connection

Connect one V6 to one PLC (1:1). V6 PLC

J ol

Via RS-232C or RS-422 (RS-485) interface

00 0000

00 0000-@

RS-422 (RS-485) Communication

f )
{::!:} For more information on connection with PLCs, refer to “V6 Hardware Specifica-

tions.”

Match signal names between V608CH (TB1) and V6 (CN1) (shown in connection
diagrams included in “V6 Hardware Specifications”) for connection. Ignore pin
numbers of V6 (CN1).

<Example>
When connecting V6 with MITSUBISHI's calculator link unit A1SJ71UC24-R4:
Refer to connection diagram 3 (page 2-1) in “V6 Hardware Specifications.”

V6 (CN1)
D-sub 25pin(Male:fh)
FG | 1 PLC
SG 7 SDA
+SD | 12 SDB
-SD 13 RDA
+RD | 24 RDB
-RD 25 SG
T * Use a twist-shielded cable.
Signal names
of V6 (TB1)
Ignore pin numbers
- J

* In the case of RS-422 interface, +SD/-SD and +RD/-RD are paired.
» If SG is present, connect the wire.
» Connect the shielded cable to PLC.

» Set the terminating resistance with the Slide switch. (Refer to “12. Slide Switch.”)

To the RS-422 port
of the PLC link unit

o e e P
Signal name ,'/ \‘\‘ % %
+RD M \ Senddata () |
-RD 3 | % Send data (+) !
+SD ‘; ; i Receive data (-) %
-SD ll, : i Receive data (+) |
SG : J > LSG J
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RS-232C Communication

-

o

.

For more information on connection with PLCs, refer to “V6 Hardware Specifica-
tions.”

Match signal names between V608CH (TB1) and V6 (CN1) (shown in connection
diagrams included in “V6 Hardware Specifications”) for connection. Ignore pin
numbers of V6 (CN1).

<Example>
When connecting V6 with MITSUBISHI's calculator link unit A1SJ71UC24-R2:
Refer to connection diagram 1 (page 2-1) in “V6 Hardware Specifications.”

V608CH V6 (CN1)
(TB1) D-sub 25pin(Male: i)
PLC
FG 1 /fV‘ 7777777 /7“ D-sub 9pin(Male: (&)
TxXD |—| SD 2 CD 1
RxD |~—| RD & RD 2
RTS [—| RS 4 SD 3
CTS |[—| CS 5 SG 5
SG [—| SG 7 DR 6
RS 7
* Use a twist-shielded cable. cs 8
Signal names on the terminal block

Connection diagram included in "V6 Hardware Specifications”

¢ Connect the shielded cable to either V6 or PLC.

V6 (TB1) Shitded To the RS-232C port
E—p— PR i - o thePLC nk un
sD :," \‘.y‘ L g Receive data %

RD ; ‘: o ! Send data i

Sl | |
cs l“, .": : :

so A ——— > | se |

* When the communication between V6 and PLC is not performed properly due to noise, SD/SG and
RD/SG are paired.

To the RS-232C port
Shielded of the PLC link unit

V6 (TB1)

Signal name

SD

RD

RS

Cs

SG
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1:n Link Communication
(Multi-drop)

One V6 and multiple PLCs are connected. (n =1 to 32)

V6

5

[- 00 0000
oo 0000

RS-422/485  Maximum length 500m
\ (from V6 to the last PLC)

TN T

Available PLC for multi-drop communication

Manufacturer Models

MITSUBISHI ELECTRIC A series link, QnA series link, QnH(Q) series link, A link+Net10,
FX series link(A prt)

OMRON SYSMAC C, SYSMAC CV, SYSMAC CS1/CJ1, SYSMAC CS1/CJ1 DNA

SHARP JW series, JW100/70H COM port, JW20 COM port

Hitachi HIDIC-H

Matsushita Electric Works | MEWNET

Yokogawa Electric FA500, FA-M3, FA-M3R

Yaskawa Electric MEMOBUS, CP9200SH/MP900

Toyoda Machine Works TOYOPUC

Fuji Electric MICREX-F series, FLEX-PC series, FLEX-PC COM(T)

KOYO ELECTRONICS SUISG, SR-T

Allen-Bradley PLC-5, SLC500, Micro Logix 1000

GE Fanuc 90 series

TOSHIBA T series

Siemens S7-200 PPI, S7-300/400MPI*

SHINKO ELECTRIC SELMART

SAMSUNG SPC series, N_plus, SECNET

KEYENCE KZ series link, KZ/KV series CPU

LG MASTER-K500/1000, MASTER-KxxxS CNET, GLOFA CNET

FATEK AUTOMATION FACON FB series

IDEC MICRO3, MICRO Smart

MODICON Modbus RTU

TAIAN TP02
Universal Serial

* Up to 4 PLCs can be connected to one V6.
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Multi-drop Communication (RS-422)

Refer to the PLC manual of each manufacturer for connection.

<E.g.>
The following example describes how one V6 is connected to three PLCs made by MITSUBISHI.
See MITSUBISHI's manual for further details.

V6 (TB1) Link unit Link unit Link unit
Signal Signal Signal Signal
FG - —1 FG | - , - ’_1 FG | - F - '_1 FG
+SD " RDA (— A RDA [— = RDA
-SD _J/ ‘1 RDB ,_/ —~ RDB [— ,_/ RDB
+RD = SDA [ = SDA /" *— SDA
-RD _J/ 1 spB ,/ SDB [ _: SDB
sG '," '," SG [—+—— sG ",‘ ",‘ — sG
RD terminal resistance T Terminal resistance T ’ Terminal resistance T ) Terminal resistance
(ON) (OFF) (OFF) (ON)

* Use a twist-shielded cable.
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10 n: 1 Link Communication

Multi-link2

Up to 4 units can be connected to one PLC.
* Between a PLC and the V6 master station is the same as those for 1:1 communication.

{z} V608CH works as only slave station.

PLC

Communication between the stations : RS-485 (2-wire system) Maximum length: 500 m

(@) l (b)

EIRC) (d) (©)
3
2
CN1| [ M2 — [c\m CN1 CN1
V6 master V6 slave V6 slave V6 slave
(Local Port 1) (Local Port 2) (Local Port 3) (Local Port 4)

» For the I/F driver, the Multi-Link 2 is supported by the version of 1.100 or later

» To use V608CH for slave station, the hardware version of the V6 master station makes sure as follows.
The hardware version record [LOT No] of V6 is on the rear side.

Hardware Version
master station
Analog type Matrix type
V612T D or later
V612C C or later
V610S D or later .
All Hardware version
V610T D or later
V610C C or later
V608C F or later

TYPE :V610T
LOT No  :9040054 Hard Version
INPUT :100-240VA
CURRENT :0.6-0.4A
[€) Hakko Electronics Co., Ltd.
MADE IN JAPAN

* The Multi-Link 2 cannot be used with a communication interface unit such as CU-00, 01, 02, 03, 04, 05.

* The Multi-Link 2 cannot be used with Temperature control network.
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Available PLCs for multi-link2.

As of December 2003, the PLCs supported are as follows. All the PLCs which are usable for 1:1

communication will be supported.

Manufacturer

Models

MITSUBISHI ELECTRIC

A series link, A series CPU, QnA series link, QnA series CPU,
QnH(Q) series link, QnH(A) series CPU, QnH(Q) series CPU,
Q00J/00/01 CPU, FX series CPU, FX2N series CPU,

FX1S series CPU, FX series link(A prt)

OMRON SYSMAC C, SYSMAC CV, SYSMAC CS1/CJ1
SHARP JW series, JW100/70H COM port, JW20 COM port
Hitachi HIDIC-H, HIDIC-S10/2alpha, HIDIC-S10/ABS

Matsushita Electric Works

MEWNET

Yokogawa Electric

FA500, FA-M3, FA-M3R

Yaskawa Electric

MEMOBUS, CP9200SH/MP900

TOYOPUC

MICREX-F series, MICREX-F series V4, FLEX-PC series,
FLEX-PC CPU, FLEX-PC COM(T), FLEX-PC series(T),
FLEX-PC CPU(T)

SU/SG, SR-T, SR-T(K prt), SU/SG(K-Sequence)

Toyoda Machine Works
Fuji Electric

KOYO ELECTRONICS

Allen-Bradley PLC-5, SLC500, Micro Logix 1000, Control Logix

GE Fanuc 90 series, 90 series(SNP-X)

TOSHIBA T series, EX series

TOSHIBA MACHINE TC200

Siemens S5, S5 PG port, S5 V4, S7, S7-300MPI(HMI ADP),
S7-300MPI(PC ADP), S7-300MPI(Helmholz SSW7 ADP),
T1500/505, TI500/505 V4

SAMSUNG SPC series, N_plus, SECNET

KEYENCE KZ series link, KZ-A500 CPU, KZ/KV series CPU, KZ24/300 CPU,
KV10/24 CPU, KV-700 CPU

LG MASTER-K10/60/200, MASTER-K500/1000, MASTER-KxxxS,
MASTER-KxxxS CNET, GLOFA CNET, GLOFA GM series CPU

FANUC Power Mate

FATEK AUTOMATION FACON FB series

IDEC MICRO3, MICRO Smart

MODICON Modbus RTU

Yamatake MX series, DMC50

TAIAN TPO2

Example of a connection between V6 units.

See Multi-link2 manual for further details.
* In order to avoid noise, wire the shielded FG only at the one of both sides so that they are not

connected.
(b) (c) | (d) (e)
V6 master Terminal block V6 slave V6 slave V6 slave
M1/ prepared by user TB1 TB1 TB1
Signal Signal Signal Signal
H - FG | - FG | - FG
[ e e /".' +— +RD —— /".' ‘+— +RD [— +RD
—~ - —=——i{ RD ——=——t RD |— -RD
; A ) i b ikt esp 5 +SD
i vl iR e | i i s | SD
i SG f—t ‘—— sG - - SG - SG
A ] VR L (SR L, 7 7
Terminal resistor Terminal resistor Terminal resistor Terminal resistor

(ON) (OFF) (OFF) (ON)
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Multi-link

Multiple V6 and a PLC are connected. (n=1 to 32)

V6:1 V6:2

g

[[-o0 0000

| oo 0000

* The connections shown below are not recommended.

RS-485 Maximum length 500m
(from PLC to the last V6)

D fe==)

5
g

[[-o0 0000
| oo 0000
[[-o0 0000

©0 0000
00 0000

|Loc 0000

Available PLCs for multi-link

Manufacturer

Models

MITSUBISHI ELECTRIC

A series link, Alink+Net10, FX series link(A prt)
QnA series CPU (with V-MDD)

SHARP JW series, JW100/70H COM port, JW20 COM port
Hitachi HIDIC-H

Matsushita Electric Works | MEWNET

Yokogawa Electric FA500, FA-M3, FA-M3R

Toyoda Machine Works TOYOPUC

Fuji Electric MICREX-F series, FLEX-PC COM(T)
TOSHIBA T series

Siemens S7-200 PPI, S7-300/400MPI*
SHINKO ELECTRIC SELMART

SAMSUNG SPC series, N_plus, SECNET

LG MASTER-K500/1000

* Up to 3 units can be connected to one PLC.
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When multiple V6 are connected to a link unit of PLC

Connect multiple V6 to a PLC by 2-wire connection.

V6 V6 V6 . )
TB1 TB1 TB1 Link unit
Signal Signal Signal Signal
FG FG -4 FG |-+ FG
+SD Lt /F . +SD . /", . +SD ,, /'”, . +RxD
-sb pH—=——+— -sb |H—=——+— -SD (H—=—— -RD
+RD i 1 b1 | +RD N B L
-RD Lo Vo -RD Vo Lo -RD Lo Lo -TxD
SG : SG e i SG o i SG
ve Y vé NN
RD terminal resistance RD terminal resistance RD terminal resistance Terminal resistance
(ON) (OFF) (OFF) (ON)

* Use a twist-shielded cable.

When multiple V6 are connected directly to MITSUBISHI’s QnA series
CPU

The optional equipment, V-MDD is required.

V6 V6 V6 V-MDD
TB1 TB1 TB1 GD port
Signal Signal Signal . y Pin No.| Signal
FG FG
+SD +SD +RxD
-SD -Sb +TxD
+RD +RD +DSR
-RD -RD +DTR
SG SG SG
RD terminal resistance RD terminal resistance RD terminal resistance 15 | -RxD
(ON) (OFF) (OFF) 16 | -TxD
* Use a twist-shielded cable. 17 | DSR
18 | -DTR
20
21




1. Modular Jack (MJ1)

1 Modular Jack (MJ1)

Modular Jack (MJ1)

Pin numbers and signal names of modular jack 1 are shown below:

MJ1 Pin No. [Signal Name Function
1 - NC
2 - NC
12345678 3 +5V Power supply for
peripheral equipment
4 +5V (Max150mA)
5 ov GND
6 ov GND
7 RD RS-232C receive data
8 SD RS-232C send data

Setting of Modular Jack (MJ1)
« Set the use of modular jack 1 on V-SFT Editor.

« Go to [System Setting] from the menu bar, and click [Modular]. Select the following options for

[Modular Jack 1].

Modular Jack 1

[Editor port]
[Barcode]
[V-Link]*

[Modbus Slave]

* For more information about “V-Link,” refer to “V-Link Manual.”

When using the modular jack, remove the I/F cover. Wall-
mount hardware cannot be used.

Screen Data Transfer
* When transferring screen data, use modular jack 1 (MJ1).

« When [Editor port] is selected for [Modular Jack 1] on the V-SFT, it is possible to select the run/local
main mode automatically. Screen data can be transferred in the run mode as well.
Also, on-line editing or simulation is possible.

* When an option other than [Editor port] is selected for [Modular Jack 1], select the local main mode for
screen data transfer. On-line editing or simulation is not possible.

* When transferring screen data, use the cable for screen data transfer (V6-CP, 3 m) for connection
between the personal computer and V6.



) 1. Slide Switch

2 Slide Switch

Setting of Slide Switch (SW1)

Setting of terminating resistance

* When V6 is connected with the PLC via RS-422/485 interface, set SW1 in the ON position.
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Installation of Neck Strap and
Cable Clamp

The neck strap, a V608CH accessory, is used to prevent the unit from dropping; another accessory, a cable
clamp is used to secure the communication cable.

Secure the neck strap and the cable clamp with screws (M3 x 10) at the machine as shown below.

o]
O]
~
J

Screw

l_ Neck strap

© | T— Cable

Cable clamp

Screw Size | Tightening Torque N-m(kgf-cm)
M3 0.3-0.5(3-5)
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4 Barcode Reader Interface

* Itis possible to receive the signal from a barcode reader by removing I/F cover from V6 and connecting
a barcode reader to V6 via the modular jack (MJ1) of V6 series.

» To connect a barcode reader to V6 via MJ1, use the cable which is the optional equipment made by
Hakko Electronics Co., Ltd. (V6-BCD).

Length :3m
Accessory : Modular Plug

12345678

Brown : +5V
Red : OV >
Orange : RXD

Yellow : TXD

Notes on Connection
« In case of using the barcode reader which uses the CTS and RTS control, the barcode reader
may not work normally without jumping RTS and CTS.

* The output power supply (+5V) is max. 150mA. (Refer to pagel-29.)

* When the barcode reader connected to V4 is used, connect it to V6 by the following cable.

12345678

Barcode Reader D-sub 9pin (1)
Signal Pin No. | Signal

RTS 1 CTS =

XD > RXD range|: RXD

RXD 3 TXD Yellow|: TXD

CTS 4 RTS

SG 5

+5V \ 6 *Jump pins, 1(CTS) and 4(RTS).
7 SG Red : OV
8
9 +5V Brown : +5V
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1 Operation of V6 Main Menu

When the power of V6 is turned on for the first time, the screen on the below left is displayed.

When power is turned on for the first time: "Main Menu" after the transfering data

o)

_lo::®ow J

(@

19985 5 090000

iOzo O

0

7 — % &EEL TFEW.
Transfer the screen data.

SHEEEYIE

EEEE AR

SAd0[EHE HEMTUAIR

©0 000
©6 000

CF Card 10 Test

~®0 0000
» OO0 0000

To move back to [Main Menu] when the screen data has been already transferred to V6, press the [SYSTEM]
switch, then press the [F1] switch when the [ENB] lamp is lighting.

If the [ENB] lamp is off, press the [deadman] switch to turn the lamp on. (see page 3-2.)

"Main Menu"

G

Main Menu] ~ veosc 1998-5 -5 09:00:00

‘System Information

S
Screen Data I PLCT) MITSUBISHI AnAINIU Er Stop
e —
| e
i 5

Connecton +1:1 BadRate 9600
SonalLevel -RS232C Daa 7
PLCSaLNo. s 1

53]
H

|
®©G 000

r®0 0000
g
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2. Operation of V6 Main Menu

[Main Menu] Screen

V6 system information or screen data information is displayed on the [Main Menu] screen.

When an option other than [Editor Port] is selected for [Modular Jack 1], be sure to select the [Main Menu] for

screen data transfer.

System program version

Screen data size

PLC model name and

V6 model name

OFF oN
Q)

““M”o““)

@

@

Main Menu @

19985 -5 09:00:00

S on Aronr F DRV VER.1.000
[SvSTEM PROG. VER. 1,300 | VER12101.10011.000 MELSEC AVANIU
JAPANESE 32

|

Dt

Treen
Information
215,

file comment set for
the screen data file

Modular jack setting

@)

o

0

g

POVIER

C Type : MITSUBISHI AnAINIU
ent : Demo

EdtortlL

CF Card

®
®

| — Font data version

| PLC I/F driver version

and model name

e
Communication parameter
contents

Brings up the [Time Adjustment] screen
(see page 2-14 for more information).

Brings up the [CF Card Transfer] screen
(see pages 2-9 to 2-13 for more information).

Brings up the [I/O Test] screen
(see pages 2-3 to 2-8 for more information).
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[170 Test] Switch

When the [I/O Test] switch on the [Main Menu] screen is pressed, the following [I/O Test] screen is displayed.
This screen is used to perform a hardware check of V6.

L Lo

OFF ON
® / !

Press the [I/O Test] switch. \

| L

E —| . P [Crevswian [ ocamanswion ]| [[swencnesc ||

Self-Loop Test
Please refer to the manual, "Hardware Specifications".

Communicarion Port

d
=]
K
5

®6 @00

OO 0§00

A. [Main Menu] Switch

Pressing this switch brings back the [Main Menu] screen.

[Main Menu] screen

D) D)

Main Menu

§

System Information [ r = | “

e
I

9
0.|C

SYSTEN

©6 000

Press the [Main Menu] switch.

~ OO0 0000
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B. [Switch Check] Switch
It is possible to check the response of touch switches on the V6 screen.
Pressing the [Switch Check] switch brings up the screen that is divided into tiles.

[Switch Check] screen

QIR
OF®ON | ‘ (‘N
)
® X: Y: Q
=> o o
@ Returm| @
Press the [Switch Check] switch. ® feee @

Press on the touch screen and check that the pressed
tiles turn white.

@z
@

When the tiles turn white, touch switches are responsive

and working properly. f °
To move back to the [I/O Test] screen, press the [F2] 0] by O
switch. 0] T o
To clear the screen, press the [F3] switch. o = " O
@ [ Erase @
Q\<@
® N ®
> 2

C. Deadman Switch

It is possible to check actuation of the deadman switch.
Hold down the deadman switch and check that the [Deadman Switch] lamp lights on the screen.

", ) . Press the deadman switch.
If the [3-Position Deadman Switch] is used, and the lamp

is lighting, check that the lamp goes off when the switch is
pressed more strongly.

=]
=]
Caremre ]

®® 00 00
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2-5

D. Key Switch (Optional)

It is possible to check actuation of the key switch.
Unlock the key switch and check that the [Key Switch] lamp lights on the screen.

m
>
Unlock the

SelfLoop T
Please refer

Self-Loop T

e

key switch.

) ©

P ® O

|
— sYs
. =
EEE oo  [oadomc] |

o @

O

©O0

E. [System] & Function Switches

Actuation of 12 switches vertically arranged on both sides of the touch screen can be checked.

Hold down each switch and check that the corresponding lamp lights on the screen.

«eooooeooooeoo»

‘o;;
.

ON‘

[

)

10 Test

Main Menu

[Drersvien J[Cocaomanswien ]| [[Sumencneck ||

SelfLoop Test

Press the [F3] switch.

N~

R

\‘\Check that the [F-3] lamp lights.
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F. Self-loop Test

This screen is used for checking the signals that are minimally required for V6 to achieve communication.

<> TB1: RS-232C Signal Test
Turn on the [TB1] switch and the [RS232C] switch in the [Communication Port] field.

Communication Port
MJ RS485

4 Loop-back test

The SD and RD signals are checked.
1. Install a jumper between "TxD" and "RxD" of TB1 on the backside of V608CH.
2. Press the [Self-Loop Test] switch and check that the [OK] lamp lights.

| cts | |[rTs cTS RTS

N
'::> (e | ~ (oK | ||
|

ﬂ Self-Loop Test ﬂ

* If the [NG] lamp lights, contact your local distributor.

@ CTSIRTS test
The CTS and RTS signals are checked.
1. Install a jumper between "RTS" and "CTS" of TB1 on the backside of V608CH.
2. Press the [RTS] switch and check that both [RTS] and [CTS] lamps light. Press the [RTS] switch
again and check that both [RTS] and [CTS] lamps go off.

:>

] Self-Loop Test ﬂ Self-Loop Test ﬂ

\\':> ——

Self-Loop Test ||r [l Self-Loop Test |]
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<> TB1: RS-485 Signal Test
Turn on the [TB1] switch and the [RS485] switch in the [Communication Port] field.

Communication Port

[rszazc |

zI
[
=

4 Loop-back test
The SD and RD signals are checked.

1.
2.

Install jumpers between "+SD" and "+RD," and "-SD" and "-RD" of TB1 on the backside of V608CH.
Press the [Self-Loop Test] switch and check that the [OK] lamp lights.

Lers | [rrs | Lers | [ers |
—> At
_OK T

[l Self-Loop Test ||

* If the [NG] lamp lights, contact your local distributor.

€ CTS/RTS test
The CTS and RTS signals are checked.

1.

Install a jumper between "+RTS" and "+CTS," and "-RTS" and "-CTS" of TB1 on the backside of
V608CH.

. Press the [RTS] switch and check that both [RTS] and [CTS] lamps light. Press the [RTS] switch

again and check that both [RTS] and [CTS] lamps go off.

'::> mw| [

ﬂ Self-Loop Test ||

=

Self-Loop Test ||

" Self-Loop Test "

N |

ﬂ Self-Loop Test ﬂ
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<> MJ1: RS-232C Signal Test
Turn on the [MJ1] switch and the [RS232C] switch in the [Communication Port] field.

Communication Port

[ont || sz
[ Rsass |

€@ Loop-back test

The SD and RD signals are checked.
Execute the test by connecting the data transfer cable (V6-CP) to CN1.

1. Connect the modular jack side of V6-CP to MJ1.

2. Install jumpers between pin no.2 side of D-sub connector and "RxD" of TB1 on the backside of
V608CH, and between pin no.3 and “TxD” of TB1.

V6-CP
TB1

RXD Pin No.2
:' Iﬁ#ﬂ“ﬂ gl |:: > MJ1
TxD Pin No.3 L

3. Press the [Self-Loop Test] switch and check that the [OK] lamp lights.

| cts | |[rTs cTS RTS
> | e e |
|

" Self-Loop Test ﬂ

* If the [NG] lamp lights, contact your local distributor.
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CF Card

Pressing the [CF Card] switch on the [Main Menu] screen brings up the following [CF Card Transfer] screen.
It is possible to transfer data between CF Card and V608CH on this screen.

[CF Card Transfer] screen

o

Press the [CF Card] switch.

|
o

o ca rarser e |

4

[meer]

®® 000

<> Folder Hierarchical Structure <>
The hierarchical structure of folders on the CF card is shown below:

( 1 Root Folders
CF Card AAAAAAAA DSP Folder Name File Name
BBBBBBBB CARD XXXXXXXX Access folder
SRAM "x_xxx" shows the access folder name that is set
cceeceee MEMO with CF Card Setting of V-SFT Editor.
RECIPE DATxxxx Folders
SAMPLE Folder Name File Name File Type
HDCOPY DSP DSPxxxx.BIN | Screen data, system programs
BITMAP CARD CARD.BIN Files for memory card mode
SRAM L
MEMO MEMxxxx.BIN | Memo pad data (xxxx : 0 to 7)
RECIPE RECxxxx.CSV | "Recipe” data
SAMPLE SMPxxxx.BIN | Sampling data (xxxx : 0 to 11)
L ) HDCOPY HDxxxx.BIN Hard copy image data
BITMAP BMPxxxx.BIN | Bitmap data
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A. Display <- Card
Data on the CF card can be transferred to V608CH
4

It is necessary to transfer a screen data to CF card from the )
V-SFT Editor in advance. Use [CF Card Manager] function of
the V-SFT, an application software for editing screen data, in
order to transfer a screen data to CF Card from the editor.
For about [CF Card Manager], See Chapter 3 “6 CF Card

L Manager” in this specification. )

1. Press the [Display <- Card] switch in the [Transfer Menu] field.
The [CF Card File Information window] is displayed.

Transfer Menu

Press the [Display <-- Card] switch%
This lamp blinks when the unit is communicating with CF card.

Crad Transfer The folder name which is currently selected is displayed.
|~ The [Access Folder Name] set in the screen data of the unit
. is used on the default status. (See page3-4.)
Folder Name : AMAAAAAA ; . .
CF Card File Information overtiame If there is no screen data in the unit, [DAT0000] is displayed
Access Rest Size kB as a folder name

DSP0000.BIN 2001-1-10 0:40:20

The rest size of CF card is displayed here.
Sys. Program V608CH
Version: 1.378

Font Data Japanese32
Version: 1.100/1.092/1.000
/F Driver General || <«—— Select a folder.
Version: 1.230 —
Screen PLC Type: Display < Card
z:;:e;;z:zmem || <«—— Select the data contents such as I/F Driver,

Font Data etc. to transfer to the unit.

|| <«—— Bring back to the former status.

The information in the current selected folder is displayed.
If the screen data does not exsit, the blank appears.

2. Select a folder on the CF Card. (Skip this process if it is not required to change a folder. )
Press the [Select Folder] switch.

The Select Folder window is displayed.
Select Folder

Select the desired folder using [1] or [{], Folder Name: AAAAAAAA
and press the [OK] switch. '
t

Folder |—AAAAAAAA
Selection !

ccceeccece

| Folder Detail |

Rest Size: xxxxxKB ||
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Press the [Folder Detail] switch to see details of each folder.
The [Folder Detail] screen is displayed.

Confirm the contents of each folder using [1] and [{] switch, and then press the [Folder Selection] switch
to move back to the [Select Folder] screen.

Folder Det

Folder Name : AAAAAAAA

DSP DSP0000.BIN
CARD

SRAM
MEMO
RECIPE
SAMPLE
HDCOPY
BITMAP

Folder Selection
Rest Size:  xxxxxKB

3. Press the [OK] switch to move back to [Card Transfer] screen.

Confirm the contents of [CF Card File Information] , and press the [Select Data] switch.
The [Data Selection] window is displayed.

4. Select the data that will be transferred to the unit, and press the [Start] switch.

Card Transfer
Data Selecti Folder Name: AAAAAAAA
CF Card File Information ata Selection Rest Size o0okB
Select All
N = Data Module
DSP0000.BIN 2001 -lﬁl
N Select [Data Module] in the [Data Selection] field
Sys. Program 1 VeQ 7 When the item of [Use Internal Flash ROM as
VERSION: 1.3 ‘ Back-up Area] is checked in the [Environment
ont Data .
Font Data . IAH ) I o Setting] of the editor.
VERSION: 11
I/F Driver : GE Data Module " Select Folder "
VERSION : 1.2
Screen PLC Type : Display <-- Card
Screen Comment : —

Data Module

5. The [Start] switch changes to [Transferring] and blinks.

When the transfer has been completed successfully, the following window is displayed. Press the [OK]
switch.

Work normally finished. |

For information about other messages, see page 2-13.
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B. Display -> Card
Data in V608CH can be saved on the CF card.

1. Press the [Display --> Card] switch, and then the [Card Transfer] screen is displayed.

Transfer Menu
|
[N
oo

Press the [Display --> Card] switch.
This lamp blinks when the unit is communicating with CF card.

- The folder name which is currently selected is displayed.

= The [Access Folder Name] set in the screen data of the unit
Folder Name is displayed as the default. (See page3-4.)
CF Card File Information Access Rest Sie o0kB If there is no screen data in the unit, [DAT0000] is displayed
~ as a folder name
DSP0000.BIN 2001-1-10 0:40:20 ™~ The rest size of CF card is displayed here.
Sys. Program V60BCH
Version: 1.378
Font Data Japanese32
Version: 1.100/1.092/1.000
UF Driver General

Version: 1.230
Screen PLC Type: Display —> Card
Screen Comment — )
Data Module || <«—— Select the data contents such as I/F Driver,
- Font Data etc. to transfer to the unit.

|| <«—— Bring back to the former status.

The information in the current selected folder is displayed.
If the screen data does not exsit, this field keeps blank.

2. Confirm the [CF Card File Information], and press the [Start] switch.

e A
When the [CF Card File Information] field is displayed on the
screen, data in the unit is overwritten. Take note that the
pre-data is gone off when the overwrite is executed.

If the [CF Card File Information] field is blank, a new file is
created in the DSP folder located below the [Folder Name]

L J

3. The [Start] switch changes to [Transferring] and blinks.

When the transfer has been completed successfully, the following window is displayed. Press the [OK]
switch.

| Work normally finished.

For information about other messages, see page 2-13.
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C. Display <-> Card
Data in V608CH can be compared with that on the CF card.

1. Select [Display <-> Card] in the [Transfer Menu] field, and press the [Card Transfer] screen is dis-
played.

2. The [CF Card File Information] is displayed.
Data in this screen can be compared with that in the unit.

The screen data in V608CH can be compared with the data in
the folder with the same name as the [Access Folder Name]
set in the editor only.

3. Press the [Start] switch.
4. The [Start] switch changes to [Transferring] and blinks.

5. When the comparison has been completed, a window is displayed. Follow the instructions displayed
on the screen.

& Message Display in Data Transferring
If an error occurs during transferring data, the message
display window shown on the right is displayed. The kinds ok |
and the contents of the messages are as shown below.

In case V608CH, the word [Memory-Card] in the following
table is [CF card].

Message Contents
Work normally finished. The specified operation has been concluded normally.
Memory-Card not setting A memory card is not inserted.

(Or in case of trying to write data into a memory card
when inserting FROM type memory card)

Memory-Card Capacity over Cannot write the data into a memory card because
the data size in V6 is larger than the capacity of
a memory card.

Writing Error occurred. The error occurred while writing data into a memory
card.

Selected data does not exist. The data in the reading target does not exist.

V6 type is different. The specified type of the data in V6 is different from the
type of the memory card data.

Selected data can not be read. The data in a memory card cannot be read.

Reading Error occurred. The error occurred during writing data into a flash
ROM of V6.

Data discrepant There is some discrepancy in data, when comparing data

between a memory card and V6.

Screen data on V6 will be broken. This message appears to inform the user that the data in
V6 will be broken by transferring the font data (the size
which is larger than the present data) from a memory
card to V6. (The [OK] switch continues the transferring.
The [Cancel] switch stops transferring.)

Undefined Error occurred. The error occurred due to some cause other than
the above mentioned.
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Time Adjustment

When the clock built in V608CH is used, the time can be adjusted on the [Time Adjustment] screen.

Pressing the [Calendar] switch on the [Main Menu] screen brings up the following [Time Adjustment] screen.

% ooooooooooooo)

Press the [Calendar] switch.

\J

[e]

[Time Adjustment CERE || vanven ||

Date and Time Adjusument

Date : 1998 - -
Time o]

I =]

O

®6 000

1. Set the current date and time using the [«], [-], [+] and [-] switches on the screen.

2. Press the [Set] switch to determine the setting. The date and time indicated in the top of the screen
changes accordingly.

To use the internal clock of V608CH, check [Use Built-in
Clock] in the [Built-in Clock Setting] dialog of V-SFT Editor
beforehand. (See page 3-3.)
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2 Function Switches

Type

[SYSTEM], [F1], [F2], [F3], [F4], [F5], [F6], [F7]

the [SYSTEM] switch

By pressing this switch, the functions of the switches [F1] ~ [F7] are defined. :
The type of the [SYSTEM] switch is alternate. When this switch is pressed once, the -
switch menu is displayed by the side of the function switches [F1] ~ [F5], and each
function switch corresponds to an item on the displayed switch menu.

When the [SYSTEM] switch is pressed again, the switch menu which is displayed on
the screen will disappear, and the switches [F1] ~ [F7] make outputs to PLC as defined

by the user.

Function of [F1] ~ [F5] when the switch menu is displayed

O [F1]: Mode

'e

o

=TT

©0 000

This switch changes the operation mode.
Main Menu Mode --> RUN Mode
Run Mode --> Main Menu Mode (possible to specify the changing time)

O [F2] : Contrast Adjustment (dark)
This switch adjusts the contrast of LCD. When the [F2] switch is pressed once, the LCD color be-
comes dark. If this switch is held down for 1 second, the LCD color changes rapidly into darkness.

O [F3] : Contrast Adjustment (intermediate)
This switch also adjusts the contrast of LCD. When the [F3] switch is pressed once, the LCD color
becomes intermediate.

O [F4] : Contrast Adjustment (light)
This switch adjusts the contrast of LCD. When the [F4] switch is pressed once, the LCD color be-
comes light. If this switch is held down for 1 second, the LCD color changes rapidly into lightness.

O [F5] : Backlight

This switch turns the backlight of V6 on or off.
If you want to use this function, you have to set [Backlight] of the [Unit Setting] dialog in [System

Setting].

The following list shows the backlight function specified in the editing software.

Backlight Function Switch (F5)
ON Ignored.
Auto 1 The following actions are added to the regular functions of these items :
Auto 2 Even if the time does not reach the setting time, the backlight will turn off if the
Auto 3 [F5] switch is pressed (provided that bit 11(Backlight) of Read Area n+1 is OFF
level). (Refer to the “Reference Manual (Function)”.)
If you select [Manual], the backlight will turn on or off only when this switch is
Manual pressed. Also, you can specify the item, [Backlight Power ON Time Control].
Manual2 When you turn the power supply of V6 on ...
[ON] :the backlight is lit.
[OFF] : the backlight is off.
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3 Errors Caused on the V608CH

Communication Error

The followings are the errors which are often caused on the V6 series.

@
o o
0] Communication Error o)
(D Time-Out O This position of the message changes.
o Screen No. Received data No. o
©
Message Contents Solution

Although a request is sent for
transmission to the PLC, an
answer is not returned within the

1) Check the communication parameter.
2) Check the cable and wiring.

3) Data may be disrupted because of
noise. Fix noise.

Time-Out

required amount of time.

Error code received

An error code was sent to the link
unit by the CPU of the PLC.

Solve the problem by examining the

CPU error code.

Check I/F driver
(applicable to I/F

driver for Simulator)

When sending a communication
request to a personal computer

(simulator), there is no reply from
a personal computer.

If a simulator is not used, transfer the

I/F driver for PLC again.

g About any other errors except these errors, refer to “Appendix
3 Error” of “Reference Manual (Function).”
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Check
op:®m‘ @:
o 0
o 0
o 0]
o (0]
Screen No. Error This portion of the message changes.
Message Contents Solution
Screen No. Error There is no setting for the The screen specified by the PLC has
received screen. not been registered.
Check if a screen number which does
not exist is entered for the memory
address “n+2” of the read area.
Data has some error There is error on screen For the error details and solutions,
Error : XX (XX:XXX) create data. refer to “Reference Manual (Func-
tion).”

<> Use the item number and sub item number to confirm the location where the error took place. Confirm
error details with the error number and make corrections.

Error : XX XX : XXX

(Warning) Sub item number
Item number

Error number

< Item number
The item number shows the editing screen or the other place where the error is detected.

26 : CF Attribute Table

g About any other errors except these errors, refer to “Appendix
3 Error” of “Reference Manual (Function)”.
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SYSTEM ERROR

When a system error is detected, the following error screen is displayed.

[oFF, DN‘ \
Ji 1| /,
5
SYSTEM ERROR : 32
)
o

SYSTEM Error : XX

1: Watch dock timer error
11: Switch table error
30 : Request for displaying full error
31 : Memory allocation system error
32 : General exceptions/MMU address system error
33 : RTOS system error
34 : Memory error
(when detecting an error by self-check of RAM)
35 : Inaccurate memory error
(when detecting an access to a memory of an inaccurate memory model,

e.g. PLC or internal memory etc.)

The source of the error could be one of the following three problems. Contact the technical
support department of your distributor.

1) Program crash due to noise
2) Hardware problem

3) Bad program

Others

About any other errors like [Warning] or [Touch switch is active], refer to “Appendix 3 Error” of “Reference
Manual (Function).”
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Handy Setting

To use V608CH, select [V608CH (640*480 7.7 inches)] in the [Edit Model] dialog of [System

Setting].
X
Edit Model
WAOT (R40+480) j

V7125 [B00°R00]
7105 (8007500
V7107 (5407480
_|vr0ss (o000
\70BC (5407480
V12 [300°60012.1 inches)
VG105 (8007600 10 4 inches)

VE1D (5407480 10.4 inches)

VEDS  [B407480 7.7 inches)

VEDE (32024067 inches)

WVEDG (320724057 inches)
7

TELLUS [1280*1024)

TEITIIS i1 N2457201

Also, make settings for the deadman switch and the key lock switch in the [Handy Setting]
dialog.

1. Select [System Setting] from the menu bar, and click the [Unit BT e
ystem Sefting ool findow
Setting]. PLC Type...

The [Unit Setting] dialog is displayed. m, RIEIE on

Edit Model Selection. ..

Font Setking...
WWindows Font List

2. Select the [Handy Setting] tab.
The [Handy Setting] dialog comes up.

Unit Setting x|
Memary Expansion | Backlight | Bugze emdtdade Switch | Blink |
Touch Switchl DI0 Mem, | Overlad{ Handp Setting ’ nvitanment Setting

) i i
™ Use Kewlock Switch

Use/no use of the deadman
switch can be switched
during the run mode using
the macro command. (See
the next page.)

The selection in the [Handy
Setting] dialog is validated at
power-up.

) Cancel

[0 Use Deadman Switch]
Choose whether or not to use the deadman switch for operation.
To allow screen operation at all times, uncheck this box.

[0 Use Key-lock Switch]
Check this box to use the key switch.

To allow screen operation at all times regardless of the key switch setting, uncheck this
box.
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Deadman Switch

To prevent misoperations, V608CH is equipped with a deadman switch.

(O When the deadman switch is used:
Screen operation is available only when the deadman switch is on (ENB lamp ON).

(O When the deadman switch is not used:
Screen operation is available whether the deadman switch is on or off.

Regardless of the above, screen operation is available while
the [Main Menu] screen is displayed.

Setting Procedure
Use/no use of the dead man switch can be set in the following two methods.

(a) Select [System Setting] from the menu bar, and click [Handy Setting] in the [Unit
Setting] on V-SFT Editor (See the previous page.)

(b) Macro command "SET_DSW"

Usable Device

Internal Memory | PLC Memory | Constant | Memory Card | Indirect Designation

Fo | (SET_Dsw)
F1 O (@)
SYS(SET_DSW) F1

| F1 | 0: Notused 1: Used |

-

{jg:? The selection in the [Handy Setting] dialog is validated at
power-up (default setting).

To change the selection during the run mode, use the macro
command. The setting made with the macro command is
reset to the default when the power is turned off.




3. Built-in Clock Setting

2 Built-in Clock Setting

The current time and date can be displayed on V608CH in the following two methods:
(O To use the clock built in V608CH
(O To use the PLC's calendar data

When using the clock built in V608CH, set the [Built-in Clock Setting] dialog of V-SFT Editor.

@ Setting Item

© |System Setting | — |Built-in Clock Setting

Check the [Use Built-in Clock] box.

Clock Setting

I apping of SFE&k

Fumber of Words

- O
= temany Card Ermulation Srea i] =
= | Stare &rea for Mems Fad i] _|

™ Maryalatility b eman [ward] [$L] ] g
™| Monvalatility beman ([Dword) [$L0] ID j

QK I Cancel |

To retain calendar data when the power is off, use a backup
battery "V6H-RB," that is available as an optional accessory.

,

S|e

Calendar data can be adjusted on the [Main Menu] screen of
V608CH. Refer to "Time Adjustment" (page 2-14).
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CF Card Setting

The following three items, Access Folder Name, Use Cache and Range of Patterns to be
saved to CF Card can be set in the [CF Card Setting] dialog.

1. Select the [System Setting] from the menu bar, and click the & . ssting Tosl Windew
[CF Card Setting]. BLC Type..

Comm. Parameter. ..
Edit Model Selection. ..
Unit 3etting. ..

Fork Setting. ..
Windows Font List
Modular. ..

Function Switch Setting

Buffering Area Setting. ..

2. The [CF Card] dialog is displayed.
x|
Access Folder Name: ITEST

Ml £ SRAH

256 | word

¥ Range of pattems to be saved to CF card

Ho. |1 ::Iltolz_::ll

Cancel

[Access Folder Name]

This is used as a folder name when data is saved on the Compact Flash card (CF
card).

All the sampling data and hard copy data are stored in this folder.

Set this name within 8 characters (0 to 9, Ato Z: a capital letter).

[C Use Cache]

Check the [Use Cache] box in order to use cache.
If the [Use Cache] is checked, cache memory is allocated for each buffering area No.
Also, size of cache can be set.

I g For more information about cache, see page 3-11. ]

[[J Range of patterns to be saved to CF card]
Check the [Range of patterns to be saved to CF card] box in order to save them on the
card.
If the [Range of patterns to be saved to CF card] is checked, the setting of range of
patterns can be selected.
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CF Card Function

CF Card Function

(O Saving memo pad data for backup (see page 3-7)
Even if the power supply of V608CH is turned off, data can be saved.
The data on the CF card can be converted into a bitmap file using the V-SFT Editor (CF
Card manager).
* |t is not possible to read memo pad data created on other V6 models.

(O Saving hard copy image as a file (see page 3-7)
Hard copy image can be saved as a file using the macro command. It can be converted
into a bitmap file on V-SFT Editor for use.

(O Saving patterns (bitmap files) on the CF card (see page 3-8)
Patterns are saved in an area (bitmap folder on the CF card) other than screen data in
order to reduce the capacity of screen data used for them.
Patterns on the CF card can be displayed on the screen to save memory.

(O Saving sampling data (see page 3-9 to 3-14)
Lots of sampling data can be saved.
Sampling data can be converted into a CSV file using the macro command so that editing
on a spreadsheet is possible.
It is also possible to save data in the same format as that for memory cards or to convert
it into an MCD file that can be read from or written to the memory card editor (optional, M-
CARD SFT).

(O Saving and reading "recipe” data (see page 3-15 to 3-23)
CSV files can be read using the macro command. This is useful for changing parameter
settings, etc. Also, data in the V6 internal memory can be saved as a CSV file.

(O Transferring screen data and system programs
 Screen data can be transferred between the CF card and V608CH (refer to Chapter 2).
» Multiple screen data can be saved to enable data modification for each system.
» System programs can be transferred for updating the V608CH software version.

(O Transferring data between the CF card and the computer using CF Card Manager of V-
SFT Editor (see page 3-29 to 3-36)
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3. CF Card Function

Notes on Use of CF Cards

Note the following points when using CF cards:

1.

2.

Save a backup copy at regular intervals.

If a disk error arises and data read/write operation is defeated, perform scandisk opera-
tion on Windows98/Me/2000/XP and restore the disk. If the disk cannot be restored,
format the disk.

(Windows is a registered trademark of Microsoft Corporation. For Scan Disk and the
operation of Windows, refer to manuals for Windows.)

Do not allow file size to exceed the capacity of a CF card.

When accessing the CF card;

« turning the power off or resetting

* removing or inserting the CF card

may destroy data on the CF card.

Before removing or inserting the CF card during the run mode, check that data is not
being transferred.

The CF card can be removed or inserted while the [Main Menu] screen is displayed.

The CF card has an average life of approx. 300 thousand write operations. Conse-
quently, repeating write operations at very close intervals may shorten the card's useful
life. When saving sampling data, be careful about the sampling time. (See page 3-11.)
Also, avoid frequent write operations using the cycle macro command.
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1. Memo Pad Data Backup

Memo pad data can be saved.

Location :\MEMO folder
Type : BIN file
File name  : MEMxxxx.BIN (xxxx: 0 to 7; memo pad number)

* Setting Iltem

O Memo pad

g For the setting procedure of memo pad, refer to Chapter 12
in "Reference Manual (Function)."

4 Timing of Saving on the CF Card
* When the [Plus Block], [Minus Block] or [Block] switch is pressed

* When the screen is changed or the [Main Menu] screen is displayed from the run mode

2. Hard Copy Image File

The current screen image can be saved on the CF card using the macro command.
Location :\HDCOPY folder
Type : BIN file

File name  : HDxxxx.BIN (xxxx: 0 to 1023; screen number)
* If the file name already exists, it is named as HDOOOO~1.BIN.

@ Setting Item
© Macro command "HDCOPY"
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3. Showing Patterns on the CF Card

Patterns (bitmap files) saved on the CF card can be displayed on the screen.
Memory for screen data can be saved.

@ Setting Item

© |System Setting | - | CF Card Setting

&

& DRAM T SR

256 | word

¥ Range of patterns to be saved to CF card
Mo, |1 ote 2 =

Check the [Range of patterns to be saved to CF card] box.
Specify the range of patterns you would like to save on the CF card.

L 2 Saving Patterns on the CF Card

1. Select the [File] on the menu bar, and click the [CF Card Manager] to start writing.

2. Insert the CF card into the CF Card Reader/Writer that is connected to the com
puter.

3. Click the [Write to CF Card] of the [File], and specify the screen data.
When the screen data is saved on the CF card, pattern data is simultaneously
saved in the [BITMAP] folder on the CF card.

4. Remove the CF card from the CF Card Reader/Writer in order to insert it into the
unit.
Patterns saved on the CF card are displayed on the screen.

[g For more information on CF Card Manager, see page 3-29. ]
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It is recom-

4. Saving Sampling Data on the CF Card |

)

mended to check
[Use Cache] due

Sampling data can be saved on the CF card in the same format as it is saved in on the SRAM
card.

It is also possible to convert sampling data into an MCD file using CF Card Manager of V-SFT
Editor, so that it can be opened or edited on the memory card editor (M-CARD SFT).

Location :\CARD folder
Type : BIN file
File name : CARD.BIN

@ Setting Item
© | sampling mode
© | Memory card mode Format switch

© | System Setting | — |Buffering Area Setting |

Store Target SRAM

© [ system Setting] — [ Memory Card Seting |

No.n (Oto 15) <-=-=-===-=-----*-

I: I/F Memory
Type: Buffering File

@l System Setting | — |Others|

CF Card — Use Cache —(t Checked*1
Not checked

*1 Depending on the timing of saving, the macro command "SMPL_SAVE" may be required.

g For more information about these settings except for the CF
card, refer to Chapter 10 "Sampling" and Chapter 25
"Memory Card Mode" in "Reference Manual (Function)."

< Buffering Area Setting
Select [SRAM] for [Store Target].
Set the same number as the one set for memory card setting for [Output File].

& Memory Card Setting
Set the same number as the one set for [Output File] for buffering area setting.

Select [Buffering File] for [Type].
<& CcFcard Setting
When [Use Cache] is not checked:
Sampling data is saved on the CF card each time sampling is performed.

to the limited )

number of write When [Use Cache] is checked:

operations to the Sampling data is stored temporarily in the V6 cache, and when some data is accumu-
CF card. lated, it is saved on the CF card.

[g For more information about cache, see page 3-11. ]

< Macro Command "SMPL_SAVE"
To output sampling data in cache to the CF card at random timing, use the macro

command.
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Saving Sampling Data on the CF Card Il

Sal

mpling data can be saved on the CF card. It is not necessary to format the CF card for

screen data as was required for the SRAM card. Simply insert the CF card into V608CH.
Location :\SAMPLE folder

* No data is output to \CARD.BIN; however, some area is occupied.

Type : BIN file
File name  : SMP0000.BIN to SMP0011.BIN

*

(the number indicates the buffering area number)

Setting Item

© | sampling mode

@lSystem Setting | g |Buffering Area Setting |

Store Target CF Card
Output File No. n (0 to 15) <---

© |System Setting | g |Memory Card Setting |

No.n (0to 15) <----====---*
I: I/F Memory
Type: Buffering File
© |System Setting | — |CF Card Settingl
Use Cache —(t Checked*1
Not checked

*1 Depending on the timing of saving, macro command "SMPL_SAVE" may be required.

g For more information about these settings except for the CF

card, refer to Chapter 10 "Sampling" and Chapter 25
"Memory Card Mode" in "Reference Manual (Function)."”

)
It is recom-

mended to check
[Use Cache] due
to the limited
number of write
operations to the

< Buffering Area Setting
Select [CF Card] for [Store Target].
Set the same number as the one set for memory card setting for [Output File].

< Memory Card Setting
Set the same number as the one set for [Output File] for buffering area setting.

Select [Buffering File] for [Type].
<> CF Card Setting
When [Use Cache] is not checked:
Sampling data is saved on the CF card each time sampling is performed.
When [Use Cache] is checked:
Sampling data is stored temporarily in the V6 cache, and when some data is accumu-

CF card.

lated, it is saved on the CF card.

[ g For more information about cache, see the next page.

< Macro Command "SMPL_SAVE"
To output sampling data in cache to the CF card at random timing, use the macro
command.
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O

About Cache:

1. Cache Function
There is a limit on the number of write operations available with the CF card. The limit
does not show the total number of write operations with the CF card but the number of
write operations every unit called sector (512 bytes). It is impossible to access files (a
part of file) including the sector if the limit comes. Consequently, if write operation is
performed frequently during sampling, access may be disabled sooner than is normal.
When [Use Cache] is checked, cache memory is allocated for each buffering area
number. Sampling data is stored temporarily until the output condition (see 4. below) to
the CF card is satisfied, so that the number of write operations can be reduced.
Cache function can be used when either [Memory Card] or [CF Card] is selected for
[Store Target].

<Note>
Cache memory is volatile; when the power is turned off or when the CF card is
removed, data is lost. Therefore, before turning the power off or removing the CF
card, execute the macro command "SMPL_SAVE" to save data on the CF card.

2. Cache Size Adjustment
The sample buffer size is determined by the sampling method, [No. of Words] and [No.
of Samples]. (See page 10-17 in "Reference Manual (Operation).”) Also, the time
interval for outputting to the CF card is determined by [Sampling Time] and [No. of
Samples].
Refer to the above information and adjust the cache size to reduce the number of write
operations.
The cache size can be 256 words to 2048 words.

<Reference>
Average CF card life: Approx. 300 thousand write operations
« If data is written every 5 minutes in 24-hour operation: Approx. 3 years
« If data is written every 3 minutes in 24-hour operation: Approx. 1.8 years

3. Cache Action

Cache Size > Sampling Buffer Size

Constant Sample

1 sample : 8 words (The number of words for sample 6+2)
The number of samples : 30 times
Size of cache : 256 words

Size of sample buffer
8x30=240 words 2 Size of cache Data for 240 words stored temporarily in
256 words cache is saved to CF card when sampling
time is satisfied.
240 If sampling is performed at the interval of

10 sec., data is saved to the card every
300 sec. (5 min.).
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4.

5.

N o M w Db

<

Cache Size < Sample Buffer size

Constant Sample

1 sample : 8 words (The number of words for sample 6+2)
The number of samples : 30 times
Size of cache : 256 words

Data for 256 words stored temporarily in
cache is saved to CF card when sampling
time is satisfied.

The rest data for 144 words is saved to CF
256 card when sampling time is satisfied again.
} After that, this operation is performed over

Cache
2 The first time 256 words

Size of sample buffer
8x50=400 words

Cache and over again.
The second time 144 words

Alarm Sampling

Information on run hours, frequency, and the time when the alarm has occurred is also
saved for alarm sampling.

The data is stored in memory other than cache, and is output to the CF card together
with data in cache when the output condition is satisfied.

Output Condition to CF Card

The specified cache memory is full.

The number of sampling times specified for buffering area setting has been exceeded.
Macro command "SMPL_SAVE" is executed.

Macro command "SMPL_CSV" is executed.

The [Reset] switch for the memory card mode is pressed.

The bit for resetting (R) in the sample control memory is set.

The [Main Menu] screen is displayed during the run mode.

Note>
¢ Inthe cases of 3 and 7 above, data in all buffering areas (No. 0 to 11) is saved on
the CF card. For other cases, only data in the applicable buffering area is saved on
the CF card.
* Inthe cases of 5 and 6 above, data in cache is output and is saved into a new file
in the backup folder (see page 3-13) that is automatically date-stamped.
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6. Sampling Data Backup

It is possible to save a backup copy of sampling data stored in the \SAMPLE folder on the CF
card. Use the macro command "SMPL_BAK."

Location :\SAMPLE\date folder
<Example>
When a backup copy is saved on 2001/9/1 (September 1, 2001), it is placed
in the \SAMPLE\010901 folder. If the folder name already exists, it is named
as \SAMPLE\010901~1.

Type : BIN file

File name  : SMPxxxx.BIN (xxxx: O to 11; buffering area number)

€ Setting Item

© Macro command "SMPL_BAK"
A backup copy of sampling data in buffering area No. "F0" is saved on the CF card.

Usable Device

PLC Memory | Internal Memory | Constant | Memory Card | Indirect Designation

Fo O @)
SMPL_BAK FO
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7. Saving Sampling Data as a CSV file on the CF Card

A sampling data file \SAMPLE\SMPxxxx.BIN) in the CF card can be converted into a CSV
file and saved.

Location :\SAMPLE folder
Type 1 CSV file
File name  : SMPxxxx.CSV (xxxx: O to 11; buffering area number)

("xxxx": the same as that in the BIN file name before conversion)

@ Setting Item

© |System Setting | - | Attribute Table |

set the attribute table (that contains the display format
information) on V-SFT Editor.
For the setting procedure of attribute tables, see page 3-18.

{'g:} When converting a BIN file into a CSV file, it is necessary to

© Macro command "SMPL_CSV"
The BIN file of the specified buffering file number "F0" is converted into a CSV file.

Usable Device

PLC Memory | Internal Memory | Constant | Memory Card | Indirect Designation

FO O O
SMPL_CSV FO
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8. Transferring "Recipe" Data

"Recipe" data in the \RECIPE folder on the CF card can be imported in the V6 internal
memory.
It is also possible to transfer data from the V6 internal memory to the CF card.

a. Importing a CSV File
A CSV file in the \RECIPE folder can be transferred to the V6 internal memory.

* Setting ltem

© [ System Setting | — [Attribute Table |

© |Create CSV File | File Name: RECxxxx.csv

Saves in the RECIPE folder

display format information) on V-SFT Editor.
For the setting procedure of attribute tables, see page 3-18.

{I} It is necessary to set the attribute table (that contains the

Create a CSV file and save it in the \RECIPE folder.

O Macro Command "LD_RECIPE"
The CSV file number "F1" is transferred to the memory areas starting with "F0."

For the file number, specify the same number set in the "ITEM No." column of the
attribute table.

Usable Device

PLC Memory | Internal Memory | Constant | Memory Card | Indirect Designation

Fo O O O
F1 O O O
LD_RECIPE FOF1

<Example>
To import the REC0001.CSV file in the \RECIPE folder on the CF card to internal memory|
$u200:
\RECIPE -ERECOOOO.CSV A | B [ o [ 5 [ e T °F

REC0001.CSV ——
REC0002.CSV

w|N‘A
=
.
s
o
g
.
s
o
2

‘|¢.

o
‘ U200
$u201

Execute the macro command "LD_RECIPE $u200 1." Sua02

o $u203

ISEINE

$u204 5

° $u205 |10
o $u206 |20
© $u207 |30
$u208 [ 40
$u209 |50

-00 0000
N




3-16

3. CF Card Function

@ Setting Item

© | System setting] — [Attribute Table

b. Importing Part of a CSV File

Specified columns or rows of a CSV file in the \RECIPE folder can be transferred to the V6
internal memory.

© | Create CSV File | File Name: RECXXxX.CsV

Saves in the \RECIPE folder

@

It is necessary to set the attribute table (that contains the
display format information) on V-SFT Editor.

For the setting procedure of attribute tables, see page 3-18.

Create a CSV file and save it in the \RECIPE folder.

O Macro Command "LD_RECIPESEL"
Columns or rows of the CSV file number stored in the "F1" memory are transferred to

the memory areas starting with "FO0."

Usable Device

PLC Memory | Internal Memory | Constant | Memory Card | Indirect Designation
FO O O O
F1 O O O
LD_RECIPESEL FO F1
"F1" memory
Address Contents
n File number * * For the file number, specify the
n+l Start row number same number as RECxxxx.csv set
n+2 Start column number in the column of the attribute table.
n+3 Number of rows
n+4 Number of columns
<Example>

To import part of the REC0001.CSV file in the \RECIPE folder on the CF card to internal

memory $u100:
\RECIPE REC0000.CSV
—E REC0001.CSV
REC0002.CSV

$u0000=1 (File No. 1)
$u0001=2 (Start row No. 2)
$u0002=3 (Start column No. 3)
$u0003=1 (1 row)

$u0004=3 (3 columns)

Execute the macro command
"LD_RECIPESEL $u100 $u0000."

Row No.

Column No.

A | B8 | © [ o [ € [ F

2 3 4 5
10 2 30 40 50
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c. Creating a CSV File

Data in the V6 internal memory can be saved as a CSV file in the \RECIPE folder.

€ Setting Item

© |System Setting | g |Attribute Tablel

It is necessary to set the attribute table (that contains the
display format information) on V-SFT Editor.

For the setting procedure of attribute tables, see page 3-18.

© Macro Command "SV_RECIPE"
Data of "F1" words from the "FO" memory is saved as a file No. "F2" in the \RECIPE

folder.
Usable Device
PLC Memory | Internal Memory | Constant | Memory Card | Indirect Designation
FO O O @)
F1 ©) ©) ©)
F2 ©) ©) ©)

SV_RECIPE FO F1 F2

<Example>

To save six words from the V6 internal memory $u100 as the REC0002.CSYV file in the
\RECIPE folder on the CF card:

-00 0000

REC0001.CSV

\RECIPE -E REC0000.CSV
REC0002.CSV

Execute the macro command
"SV_RECIPE $u1006 2."

‘m ‘N‘_
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9. Attribute Table

To convert a BIN file into a CSV file, information about the display format and the word length
(single-word or double-word) is required, and should be set on the attribute table of V-SFT
Editor.

To use the following functions, the attribute table should be set:

a. To convert an SMPxxxx.BIN file in the \SAMPLE folder into a CSV file

b. To transfer a RECxxxx.CSV file to the V6/PLC memory, or to save data in the V6
internal memory as a RECxxxx.CSV file

CF Attribute (Attribute Table)

@ Starting

Select [System Setting] from the menu bar and click the [Attribute Table]. The [CF
Attribute] window is opened.

CF Attribute o ] |

: RECIPE
‘7] Sampling

L 2 Exiting
Click the upper left of the screen and select [Close] from the menu.
Or click the [X] box at the upper right corner.

| CF Attribute

= Restore KZ _ é! ;; )
Move

Size

= Minimize

or

O Maximize

( ~
Close Ctrl+F4 |4

Next Chrl+Fe
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a. Converting an SMPxxxx.BIN File into a CSV File

& Setting Item

© |System Setting | — | Buffering Area Setting

© | sampling Mode

© [system setting | — [Attribute Table |

@ CF Attribute (Attribute Table)
Attribute table No. Comments

CF Attribute

. Jilinel

Attribute Mo,

Sample Type : Bit Sampls

Correspond to “xxxx” of SMPxxxx.BIN

=10l x]

: Procedure to enter comments

1. Specify the attribute table No. to write down

comments.
2. Right-click to select [Name Change], and
write down comments.

* Up to 16 characters can be used for a
comment.

=[] RECIPE
: | Attribute o, 3:
Attribute Mo, 4!

(=] Sampling

Attribube b
Attribube b

gu

Buffering Areahlo, :
Sample Type : Consl

Tew Table..,
MNew Groun

& cut Chrl+%

Py ChrHC

Brate Chil+
Del

lete
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@ Attribute Setting

1. Select the attribute No. for attribute setting.

=101 ]

Buffering Arealo, @ 1
Attribute Mo, S:iLinel Sample Type : Bt Sample
Attribute Mo, 4:Line2
arnpling

Attribute No, 0:Trend )

Double-clicking {8 actribute Mo, 2:Alarm
also brings up the

[Attribute Setting]
dialog.

2. Click [Attribute Setting] from the [Edit] menu.
Or, right-click and select [Attribute Setting].

Edit Display Item System Setting ~

New > Hew Table, .
% cut Chrie [dew Graup

Copy Ctrl+C % cut el

2 Paste Chrl Or Copy Chrl+C
Copy bo Selected Soreen. . RIght-ClICk 2 paste ey
Undo Paste b Selected | Sereem, Delete
Delete Mame Change
Mame Change

Set &5 Default
( Attribute Setting. .. ) ( Attribute Setting. ..

& Delete Al

3. The [Attribute Setting] dialog is displayed.

< Constant Sample/Bit Synchronize/Temp. Control Net/PLC2

Attribute Setting No.0[Constant Sample] x|

Time Fomat

/o]
MM/DD hh:mm:ss
hbran: sz
MM-DD ko sz
Mt4-DD
hbrarn: sz

Number of ‘W ords used for Format.

343 Apply zame setting. |

Mo, 1 P )
Twpe DEG DEG
Decimal Point 1] 0 1]
No. of Words | 1-Word  1-Word | 1-Wiord
Characters

Preview 12345 12345 12345

Cancel |

[Time Format] field

Set the display format of data and time.
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[Setting of each data format]

Make setting for each data format. The items shown in the diagram below can be set.

Type Decimal Point (0 t032) | No. of Words | Characters (0 to 256)
DEC O 1 Word/ 2 Word —_

DEC- O 1 Word/ 2 Word —

HEX — 1 Word/ 2 Word —

OCT JR— 1 Word/ 2 Word e

BIN JE— 1 Word/ 2 Word —_—

CHAR — — (@)

BCD _— 1 Word/ 2 Word —

FLOAT O 2 Word —

Characters : the number of bytes

[Apply same setting]

Applies the format of the currently selected data to all.

< Bit Sampling
Set the display format of date and time, and items for the sampling mode.

Attribute Setting Mo.1[Bit Sample] 5[
MDD Status Display [orarr =]
b /DD hhcram: s R .
Start Message  GMo. IU :ll Mof0 :II
Display in &iea Mo =

Start Message GMo. ID iIINDU jl

Display Order % Chionological Oider —  Newest Order

Cancel |

<& Alarm Function
Set the display mode, the display format of date and time, etc.

Attribute Setting No.2[Alarm Function] : 1[

™ Display Only First Cause ¥

Dizplay Mode IDccurrance and Cancellation Time j

Calendar Condition IDate and Time j [~ Zero Suppress
Date Display IHM j I™ ‘ear d-digit Display
Time Dizplay |13'3I]'2E| j

Display Order ¢ Chronological Order € Mewest Order

Cancel |
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CSV File Examples

Examples of CSV files created using the macro command "SMPL_CSV" are shown below:

< Bt Synchronize

i SMP0000.CSV
A B [ I
No.000 D

CF Attribute No. —C
2 — o/B 0
3 55 100
4 5/5 50
5] 55 65
i 5/5 200
S
3
9

< Bit Sampling
A I B o] D E &
CF Attribute No. — Mo.00Z N
2 /5 912lErmars
& 2001 /545 812 Errore
4 2001 /55 8912 Errar?
B 2001 /545 812 Errord
i} 2001 55 8912 Errars
7 2001 /545 812 ErrorT
8 2001 55 8912 Error?
Bl 2001 /545 812 Errord
10 2001 55 912 Errard b
11
12
13
14 S
¥ [WIh, SMPO00Z J K1 | LIJJA

< Alarm Function

EjSMP0003.CSV

A B C D
CF Attribute No. —— Ng.003 >
2 IErran 6/18 16:3651 6/18 16:37.08
af Errord 6/18 16:3554 6/18 163712
4 Errors 6/18 16:3657 6/18 16:37:15
Primary cause o] Errord 6/18 16:37.02 6/18 16:37:26
G Errord 6/18 16:37.05 6/18 16:37:26
K Errord 6/18 16:37.28 6/18 16:37:32
g Errord 6/18 16:37:28 6/18 16:37:32
9 \* Errord 6/18 16:37.33 R
10 Errarg 6/18 16:37:33 AR AR
11
12
13
14
15
15
[« [» [¥i}, SMPO0DS A 1=l
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b. Transferring a RECxxxx.CSV File to V6 Internal Memory,
or Saving V6 Internal Memory Data as a RECxxxx.CSV File

@ Setting Item

© |System Setting | - |Attribute Table|

@ RECIPE folder on the CF card — | Create CSV File

REC0000.CSV

REC9999.CSV
@ CF Attribute (Attribute Table)

Attribute table No. Comments

=10l x|

Attribuke Mo, 0:Trend
Attribuke Mo, 1:6it
Attribube Mo, 2:Alarm

& Exporting to a CSV File
The attribute table created in the [CF Attribute] dialog can be saved as a CSV file.

Click [Export to CSV File] from the [File] menu, and give a file name.

<> Importing from a CSV File
An exported CSV file can be imported to the [CF Attribute] dialog after editing on a

spreadsheet, such as Excel.
Click [Import CSV File] from the [File] menu, and select the desired CSV file.




3-24

3. CF Card Function

@ Attribute Setting

Double-clicking

also brings up the
[Attribute Setting]
dialog.

1. Select the attribute No. for attribute setting.

Attribute Mo, 0:Trend
Attribute Mo, 1:6it
Attribute Mo, 2:alarm

2. Click [Attribute Setting] from the [Edit] menu .
Or, right-click and select [Attribute Setting].

Edit Display Item System Setting ~

Mew 3
& cut Ctrl+i
Copy Chrl+C
B2 Easte Chrl

(Copy o Selected|Sereen, .,

Undo Paste bo Selected Screem;..
Delete

Mame Change

( Attribute Satting. ., )
&, Delete ol

Hew Tiable: .
HEW Group
& cut Chrl+x
Or Copy Chrl+C
f f Easte ChH 4,
Right-click e
Delete

Mame Change

ek as Default
Attribute Setting. ..

3. The [Attribute Setting] dialog is displayed.

Attribute Setting No.3[Recipe]

= Use Title
I= Wse Becord Hame ’7

i Data

Tranzfer Mode
' Fecord Name + Data

I5 jl Butes for Becord Hame

Colurns
Total Words i Apply zame selling.l
Ma. T e [ e s
Type ~| DEC DEC DEC DEC
Decimal Point 0 1] 1] 0 0
Mo of Words | 1-Word  1-Word  1-Word  1-Word | 1-Wiord
Characters
Presien 12345 12345 12345 12345 12345

~ Inthe case of RECkzxs CEY.

REC IU ﬂ 5y

Cancel
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[The number of Column] (1 to 4096)

Set the number of columns in CSV files.

* The maximum number of columns is [4096]. However, depending on the
setting contents of each data, the number is automatically limited if the [Total
Words] reaches to [4096] words.

* The maximum number of columns to handle CSV files on Excel is [256].

[Setting of each data format]

Make setting for each data format. The items shown in the diagram below can be set.

Type Decimal Point (0 t032) No. of Words | Characters (0 to 256)
DEC O 1 Word/ 2 Word —_—

DEC- O 1 Word/ 2 Word —_

HEX — 1 Word/ 2 Word —

OCT JR— 1 Word/ 2 Word e

BIN P 1 Word/ 2 Word —_—

CHAR — — O

BCD —_ 1 Word/ 2 Word -

FLOAT O 2 Word —

Characters : the number of bytes

After making all the settings shown above, the [Total Words] (1 to 4096) is automatically

displayed.
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Procedure to set Attribute Table Newly
1. Click the [Attribute Table] from the [System Setting], and the [CF Attribute] is displayed.

£Z| CF Attribute

#* RECIPE
1 Samplirg

2. Select the [RECIPE] folder, and right-click to display the following menu.
Click the [New Table].

CF Attribute

-7 ampli Mew Table. .
hew Group
b Cut ChE|+
Copy. ChrlHC
B2 paste el

3. The [Attribute Setting No.0] dialog is displayed.
For the setting items in this window, see page 3-25.

Attribute Setting No.D[Recipe] : |

™| sz Title Transfer Mode
s Data € RecodH st
™| Use Fecord Name ’7 e bl

Columnng I18 j Butes for Record Mame ID j

Total words 16 Apply same setting |
Mo, 1 I e
Type DEC DEG  DEC  DEG  DEG
Decimal Paint 1] 1] 0 0 1] 1]

Mo, of Waords | 1-Word  1-%lord 1-Word 1-Word 1-Word 1-Word 1
Characters

Preview 12345 12345 12345 12345 12345 12345

—In the case of RE Cxxex. CSY.

FEC IU i’ 5

Cancel |
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5 System Memory

Statuses of the deadman switch, the key switch, external output switches, and the CF card
are output to the system memory ($s).

The contents of $s490 to 499 and $s780 are explained in this section.

For information on other memory areas, refer to "Appendix 1" in "Reference Manual (Func-
tion)."

List of System Memory Contents

Address Contents Memory Type
$s490 V608CH Switch setting of key switch/deadman switch
$s491 V608CH Answerback of each switch <V
$s492 V608CH Backup battery (V6H-RB) status
$s493
$s494
$s495
$5496
$s497 CF card error status
$s498 CF card free space (low-order) Unit: Kbytes v
$s499 CF card free space (High-order) Unit: Kbytes
$s780 CF card BMP file load information

Address Details

O $s490
Information on whether or not the deadman switch, the key switch and the ENB lamp are
valid is output.

(e [wn]wlaow]s o7 [s]s]«[s]2]]0]

‘ Key switch
un 0: Invalid
0" for all 1: Valid
Deadman switch
0: Invalid
1: Valid
ENB lamp —
0: Invalid
1: Valid
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O $s491
Answerbacks of the output switches, the deadman switch and the key switch are output.

|15|14|13|12|11|10|9|8|7|6|5|4|3|2|1|0|

Key switch
"0" for all Deadman switch
SW4 SW3 SW2 Swi
Output switches
O $s492
The status of built-in clock backup battery (V6H-RB) is output.
0: Normal

1: Battery voltage drop (Replace the battery.)

O s$sa97
The result of access to the CF card is output.

4 No card inserted

Small card size

Invalid card type

12 Card write error
15 Disk error (open failure)
16 Card read error

O $s498 to 499
Free capacity (kbyte) of the CF card is stored.

O ss780
The bitmap file loading information is output.

(e [w]w]wlafow]s o7 [s]s ]« ]2 0]

"0" for all

0: Compatible with the file format 0: File exsits.
1: Incompatible with the file format 1: File not exsit.
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6 CF Card Manager

To perform data transfer between V-SFT Editor and the CF card, convert files with the
extensions of [.V6] or [.bmp] into a file format so that the unit can read the data, and then

save it on the CF card.

Also, it is required to convert a file into the file with the extension of [.V6] or [.bmp] in order to

see the data in the card on computer.
CF Card Manager enables to convert these files described above.

Starting CF Card Manager (page 3-29)
Writing Data into CF Card (page 3-30)
Copying CF Card (page 3-33)

Back-up of CF Card (page 3-34)

mnmoow>»

Others (Property) (page 3-36)

A. Starting CF Card Manager
1. Click [CF Card Manager] from the [File] menu.
2. The following dialog is displayed.
Select the CF card drive and click [OK].

Not only the CF card drive but other drives can be selected in
this window.

Select the drive of CF x|
=] 0K

Cancel

3. [CF Card Manager] is started.

Converting a BIN File back to the Original Format (page 3-35)

’m Edit Display Draw Part Item
[ taew i+
= Open...

u Save Ctrl+S
Save As...

Property...

K Transfer...
Send AT command. ..
Cn-line Editing

% on-line: Run

Printer Setting. ..
=1 Crkp
Present Window Printing  Ckrl4Q)

( CF Card Manager... )

B Stark Simulatar.

HV Series Editor for Windows Wersion 2.10 - CF Card Manager{h:¥)} =E
Eile Edit Display Window

DedBpZa %% | L HE-%esE 7

[®7 CF Card Manager(h:¥) B ]

~-{=) Remaovable Disk {H:) File: Kind of File

Size | Renewal Time

Ready
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B. Writing Data into CF Card

© sScreen Data (.V6)
Convert the selected screen data into the BIN file format so that the unit can read the
data, and then write it to CF card.

File Edit Display ‘wind:

1. Click the [Write to CF Card] from the [File] menu. Emeurp off GF el
_ o ( Write ta CF Card )
2. The [Write to CF Card] is displayed. CF Card Copy
x| PUL BIN File Back..
File to be converted Froperts,..
Refer. =
Quit Application

File comment of BIN file

[ Use default loading
= Upload system program automatically.

Cancel

[File to be converted] [wiite tocrcard 0 X
Click the [Refer], and specify the file to be written to CF Fie 0 be comvered

card. [ #detahardipctest v Refer..

Select the [Screen Data File(*.V6)] as Files of type.

File comment of BIN file
Idemu

[File comment of BIN file]
This area is used to give a comment to the file (BIN file)
written to CF card.

I™ iize default loading
I | Upload system progranm automatically

Cancel

Click the [OK].

3. Afolder set in the [Access Folder Name] is created on the CF card.

[ CF Card Manager(h:¥)

[=)-=) Removable Disk (H:) File Kind of File
-_| DATO000 _paTaono File Felder

The created folder name on the CF card comes
from the [Access folder name] set
in the [CF Card Setting] of the V-SFT Editor.

he
= ORAH| £ SRk

256 | word

¥ Ranna af nattame tn ha sawvad ko CF card
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© Memory Card Data (.mcd)
Convert the selected memory card data into the BIN file format so that the unit can
read the data, and then write it to CF card.

File Edit Display ‘Wind:

1. Click the [Write to CF Card] from the [File] menu. B of @ eaid
2. The [Write to CF Card] is displayed. (Cwerocrcad

CF Card Copy

Write to CF Card x|

File to be converted

Put BIN File Back,, .

Refer Property...

Quit Application

File comment of BIN file

[ Use default loading
= Upload system program automatically.

Cancel

[File to be converted]
Click the [Refer], and specify the file to be written to CF

‘Write to CF Card

File to be: converted

card. D¥dal#handy#test MCD Refer |

Select the [Memory Card File(*.mcd)] as Files of type.

File comment of BIM file:

Idemo
[File comment of BIN file]
This area is used to give a comment to the file (BIN file)
written to CF card.

ind
pload spstem program automatically.

Cancel |

Click the [OK].

3. The [Specify Save Target] dialog is displayed.
Enter an access folder name to save a mcd file, and click the [OK].

Specify Saye Target x|

Specify the name of access folder for zave

Cancel |

4. Afolder is created in the CF card.
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There are 8 folders shown in the following diagram under an access folder name in CF
card.

@7 CF Card Manager{h:¥) i IE

File Kind of File |

CJoaToooo File: Falder

[BITMAP]

The item of [Range of patterns to be saved to CF card] can be set on V-SFT in order to
save the size of screen data. (Relevant to page 3-8)

Pattern data set in this window is saved in CF card.

[CARD]
Both recipe data and sampling data stored in SRAM are saved in a file.
(Relevant to page 3-9)

[DSP]
Screen data, sys. program, I/F driver, and font data are saved in a file.

[HDCOPY]
Data when the [HDCOPY] macro is executed in the unit is saved. (Relevant to page 3-7)

[MEMO]
Memo pad data in the unit can be saved.

[RECIPE]

CSV files to execute [LD_RECIPE] and [LD_RECIPPESEL] macro are saved in this folder.
(Relevant to page 3-15, 16)

Also, CSV files when [SV_RECIPE] macro is executed are saved. (Relevant to page 3-17)

[SAMPLE]
Sampling data stored in [CF Card] is saved every buffering area here.
(Relevant to page 3-10)

[SRAM]
This folder is not available for V608CH.
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C. Copying CF Card
1. Click [CF Card Copy] from the [File] menu.

File Edit Display ‘Wind:
Back-up of CF card
‘Wite to CF Card

CF Card Copy

Fut BIM File Back. ..
Property. ..

Quit Application

2. Select the CF card drive and click [OK].

Sclectthe drive of CReaiaEY|
Al ok

Cancel

3. The following dialog is displayed. Click [OK].

V-SFT

& ‘will copy CF card. Mever remove CF card during copying.

4. Remove the source CF card from the computer and insert the target CF card. Click
[OK].

Y-5FT

@ Exchange CF card.

5. The following dialog is displayed. Click [OK] in the dialog.
V-SFT

& “wiill warite in CF card. Mewer remove CF card during copying.

6. When copying has been completed, the following dialog is displayed. Copy operation

is complete. ST B

@ Copy finished.
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D. Back-up of CF Card
Data on the CF card is saved as back-up.
The target place where back-up is saved can be selected freely.
1. Click [Back-up of CF card] from the [File] menu.

2. The [Back-up of CF card] dialog is displayed.
Click the [Refer] in order to specify the place where the data is copied.

Copy Target Folder |

Specify the copy target folder.

Hefer...l
oK I Cancel |

<Example>
When data is saved in the My Document of C Drive.

Copy Target Folder ﬂ

Specify the copy target folder.

II::¥ My Documents Hefer___l
ak. I Cancel I

3. Click [OK], and the following dialog is displayed.

V-S5FT <]

& Wil copy CF card. Mever remove CF card during copying.

4. Click [OK]. The data on the CF card is copied to the target copy.
When copying has been completed, the following dialog is displayed to finish this
operation.

V-SFT

@ Copy finished.

5. Check that data is copied on the Explorer.

The functions of copy and paste are also available to copy the data on a CF card to
Hard Disk.
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E. Converting a BIN File back to the Original Format

All the data written to CF card has the same extension of [.BIN] after executing [B. Write to

CF card]. (See page 3-29.)

BIN files can be converted back to the original file format.
The following files can be converted.

Folder

Extension after Conversion

BITMAP  .bmp
CARD

DSP .V6
HDCOPY  .bmp
MEMO .bmp

€ Procedure

1. Select the file to be converted.

.mcd (for M-CARD SFT Editor)

2. Click [Put BIN File Back] from the [File] menu.
Or, right-click and select [Put BIN File Back].

@7 CF Card Manager{h:¥)

[=]-i=D Remowable Disk (H:)

£+ DaToooo
{3 BITMAP
(1 carD

1 psP
1 Hocopy
1 MEMO
{1 RECIPE

(1 SAMPLE
(2] sRam

3. The [Save As] dialog is displayed.

Select the location, give a file name,

and click [Save].

4. A file with ".BMP" extension is created.

[®7 CF Card Manager(h:¥)

Put BIM File:

Property...

=10l x|
File: ¥ind of File [ Size
& BIM File 274t
Bocue Chrl+x
Copy Chr+C
2 Eacte ChrlY
Delete
Select All
Latest Information

2l x|
Save n: [ 4 BITMAP | « & ek B
File name: |E|E|E|1 Save I
Save as lope: [["BMP] =] ceeel |
&
i ] 4

[=-=) Remavable Disk (H:}

=] DATOO0O

i EITMAP

-] CARD
-] psp
] HDCOPY
] MEMO
-] RECIPE
] SAMPLE
L SRAM

| Eilz Kind of File Sizt
C " 0001.6MP Bitrnap [mags 7,990
[#]EMPODO1, BIN BIM File 274t
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F. Others

@ BIN File Property
Select a BIN file, right-click, and select [Property]. The file information is displayed.

<Example>

(O BMPxxxx.BIN/HDxxxx.BIN/MEMxxxx.BIN
The bipmap image is displayed.

File Comment

48, 48
CL25E

(O DSPxxx.BIN
The file type, version number, etc. can be displayed on the [Detail] tab window.

Property of DSPDODD.BIN 5[

| Extended Font Info I

Kind | Commment I Size | &
Screen Data =]
System Program VEOBCH 520720 B
I/F Drriveer MELSEC AnddN... 0144 E
Temp. Contral Metwark/PLC, 1]}
Fort JAPAMESE 32 762,064 B
Data Module 0B
Madbus Slave Communication o
Ladder Toal [il:)
Finter Driver 0B
Ladder Moritor 0B -
o | i

FLC

Connecte  WEOBCH (5407480 7.7 inches)

oK I Cancel | Lpply |

The [File comment] entered at the time when [Write to CF card] is executed can be
displayed on the [General] tab window.

Property of DSPO0O0O.BIN x|

Write to CF Card x|

| Dietail | Extended Font Info

5 File to be: converted
[SPO000.BIM D¥datz¥handyétest MCD Refer |

File comment of BIM file:

‘ File Comment:  demo ; :demo

Kind:
Size: 1829447 Byte

™| Upload system program automatically
Fenewal 2003F 108 65 09:35:56

Cancel |

Ok I Cancel Apply
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